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1.1

1.1.1

1.1.2

1.1.3

1.1.4

1.1 Compliance

Safety and Certifications

Compliance

CLARUS™ 500 from ZEISS is compliant with ISO 10940:2009 and
ISO 15004-1:2006.

Laser Safety and Compliance

NOTICE

LASER RADIATION
BELOW HAZARD LIMITS

CLASS | LASER PRODUCT

Optical Safety

CLARUS 500 is compliant with the following optical safety
standards:

m |[EC 60825-1
m ANSI Z80.36
m [SO 15004-2

m Classification: Group 1 Instrument - Per ANSI Z80.36 and ISO
15004-2

Group 1 instruments are ophthalmic instruments for which no
potential light hazard exists.

m Class 1 Laser Product — Per IEC 60825-1.

RoHS Compliance
The product is RoHS-compliant according to Directive 2011/65/EU.

Electrical Safety

Electrical Safety Class | Equipment - Protection against electrical
shock (per IEC 60601-1).

2660021165005 Rev. B 2017-10
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1.2 Symbols and Labels

: Warning
i Caution
Note
rd
l:lj .
Electricity

Must follow Instructions for Use

QP

Power On (computer)

Power Off (computer)

Protective Earth

Fuse

Direct Current

Type B Applied Parts

Manufacturer

> [1(DO

107182 2660021165005 Rev. B 2017-10
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Authorized European Community Representative

Serial Number

SN

Catalog Number/Part Number

MODEL Model Number

Certification mark of CSA — Nationally Recognized
Testing Laboratory for US and Canada

Disposal of the Product within the E.U. Do not dispose
via domestic waste disposal system or communal waste
disposal facility.

Fragile

44 | Keep Dry

This End Up

Transport conditions: humidity (10% to 95%)

2660021165005 Rev. B 2017-10 117182
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+70c] | Transport conditions: temperature (-40°C to 70°C)

1060hPA | | Transport conditions: atmospheric pressure (500 hPa to

@ 1060 hPa)

500hPA

Caution: Federal law (or United States) restricts this
device to sale by or on the order of a licensed healthcare

R“ 0"'}' practitioner

1.3 Warnings, Cautions, and Notes

1.3.1 Definitions

Warnings and cautions are defined as follows:

Indicates hazards that, if not avoided,

/A WARNING! -
could cause severe injury or death.
» These are actions that can be taken to prevent the hazard.
A CAUTION! Indicates hazards that, if not avoided,

could cause minor or moderate injury.

» These are actions that can be taken to prevent the hazard.

1.3.2 Warnings

/A WARNING! Opening the device covers

may result in injury.

» Only ZEISS authorized service technicians may remove device
covers.

/A WARNING! Tipping the device

may result in injury.

» Do not allow the patient to lean on the table or use it as a
support to stand up.

127182 2660021165005 Rev. B 2017-10



Instructions for Use

1 Safety and Certifications

2660021165005_Rev_B

/A WARNING!

/A WARNING!

/A WARNING!

/A WARNING!

/A WARNING!

1.3 Warnings, Cautions, and Notes

Modifying this device
may increase risks and decrease the service life of the device.
» Do not use in the presence of flammable gasses.

» Do not use in oxygen rich environments.

Using this device in the presence of flammable gases
may cause ignition and result in a fire hazard.

» Do not use this device in the presence of flammable anesthetics
or oxidizers such as pure oxygen or nitrous oxide.

Use of this equipment adjacent to or stacked with other
equipment

should be avoided because it could result in improper operation.

» If such use is necessary, this equipment and the other
equipment should be observed to verify that they are operating
normally.

Use of accessories, transducers, and cables other than those
specified or provided by the manufacturer of this equipment

could result in increased electromagnetic emissions or decreased
electromagnetic immunity of this equipment and result in improper
operation.

» Use only the accessories, transducers, and cables specified or
provided by ZEISS.

Adding peripheral equipment or replacing parts

may result in noncompliance with the safety requirements of IEC
60601-1.

» You are responsible for ensuring that the system meets the
safety requirements of IEC 60601-1.

» Only approved equipment to their respective IEC/ISO standards
such as IEC 60601-1 or IEC 60950 are allowed to be connected
to the Signal Input/Output parts (SIP/SOPs).

» Place any AC-powered, non-medical device peripherals at least
1.5 m away from the instrument and connect them to a
separation device, unless an isolation transformer is used.

2660021165005 Rev. B 2017-10
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Unplugging the power cord is the means of disconnecting
from the power supply.

Blocking access to the plug may result in an electrical hazard.
» Set up the instrument so that it can be unplugged easily.

Using parts that are not authorized by ZEISS
may compromise device safety during operation.
» Use only accessories authorized by ZEISS.

» Inthe U.S., call 800-341-6968. Outside the U.S., contact your
local Zeiss distributor. You can find the ZEISS contact partner
for your country on our website: www.zeiss.com.

Class 3B laser radiation
when open.
» Avoid exposure to beam.

Contact with the patient and a peripheral device
may cause an electric shock.

» Do not touch the patient and a peripheral device at the same
time.

Device produces visual stimuli, including flickering light and
flashing patterns, between 5 and 65 Hz

may adversely affect certain patients, although this effect is yet
unproven.

» Medical professionals need to determine whether this device
should be used for patients who may be photosensitive,
including those with epilepsy.

Unqualified personnel

may injure themselves or cause damage to the instrument.
» Only trained, qualified personnel may use this device.
» This device may be used only for its intended purpose.

» Only ZEISS authorized personnel may perform maintenance or
repair procedures not described in this manual.

147182 2660021165005 Rev. B 2017-10
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/A WARNING!

1.3.3

/A CAUTION!

A CAUTION!

A CAUTION!

1.3 Warnings, Cautions, and Notes

Use of the acquisition device, a printer, or the power table
with an extension cord or a power strip (multiple portable
socket outlet)

could cause electrical shock to the patient or operator.
» Do not use extension cords with the instrument.
» Do not use power strips with the instrument.

» Do not plug in any other equipment into the same wall outlet
as the instrument.

» To avoid the risk of electric shock, this equipment must only be
connected to a supply mains with protective earth.

Cautions

Use of controls or adjustments or performance of procedures
other than those specified herein

may result in hazardous optical radiation exposure.

Attempting to carry out activities not specifically endorsed
by ZEISS

may void your warranty and could result in damage to the
instrument.

» Read the user documentation.
» Follow directions carefully.

» Do not make upgrades, or carry out repairs or modifications,
without specific guidance and instruction from ZEISS or an
authorized ZEISS represenative.

Improper cleaning
may result in inadequately disinfected equipment.

» Refer to the cleaning instructions in this Instructions for Use
and local and national disinfecting regulations.

2660021165005 Rev. B 2017-10
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A CAUTION!

A CAUTION!

A CAUTION!

A CAUTION!

A CAUTION!

2660021165005_Rev_B

Internet connection of the CLARUS 500

increases its vulnerability to serious security risks, including viruses
and worms that could disable your system or adversely affect its
performance and may void the instrument warranty.

» Transfer data through internal networks.

» Ensure that all firewalls and internet security applications are
up-to-date and running.

» Connecting the device to the internet or transferring data via
USB devices may result in compromised patient privacy and
expose the network to malware.

Installing or putting the device into service without regard to
EMC information provided

may void your Device warranty, result in damage to the instrument
and/or compromise safety for patients and operators.

» The CLARUS 500 has special EMC precaution requirements and
needs to be installed and put into service according to the EMC
information provided herein.

Using this instrument with patients who are light-sensitive,
including epileptics

may cause nausea or harm to the patient.

Attempting to decommission your system
may result in damaged equipment and danger to personnel.

» Never attempt to decommission a ZEISS system or instrument.
Only ZEISS approved representatives are qualified to safely
decommission your system.

» Contact your ZEISS approved representatives to set up an
appointment for system or instrument decommissioning.

Packaging and transport by non-ZEISS personnel

could result in damage, loss, or non-compliance within the country
of transit.

» Allow only change to Zeiss approved representative to prepare
the instrument and associated components for transport.

» Allow only ZEISS-approved personnel to transport the
instrument and associated components.

16/182
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A CAUTION!

/A CAUTION!

A CAUTION!

A CAUTION!

1.3 Warnings, Cautions, and Notes

Do not lift or carry the instrument using the patient support.
The patient support could break if used as a carrying handle.

» Make sure you support the instrument from the base whenever
you carry the instrument.

Portable RF communications equipment (including periph-
erals such as antenna cables and external antennas)

should be used no closer than 30 cm (12 inches) to any part of the
device, including cables specified by the manufacturer.

» Otherwise, degradation of the performance of this equipment
could result.

The CLARUS 500 is intended for use in a professional
healthcare facility environment.

Using the instrument in any other environment may void the
warranty and compromises the safety of the patient and/or
operator.

Image Degradation

If image quality is degraded or image is absent from display, please
contact Zeiss customer service.

» The physician must decide whether the image is appropriate for
diagnosis

Notes

Transferring data via USB devices

may result in compromised patient privacy and expose the network
to malware.

» Use access controls to ensure that only authorized personnel
use the device.

NOTE

1.3.4
NOTE

Connecting the device to a network that includes other
equipment

may result in previously unidentified risks.
» You are responsible for analyzing and controlling these risks.

» You must reassess these risks when you make any changes to
the network, including connecting, disconnecting, or upgrading
equipment.

2660021165005 Rev. B 2017-10
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NOTE Unprotected devices
may be at risk from unauthorized individuals.

» Select and set the Password strength setting in the User
management screen.

1.4 Report Serious Accidents

Report any serious incident related to this instrument, the operator,
patient, or anyone else:

m To the instrument manufacturer or distributor.

m (European Union only) To the competent authority in the state
where the instrument operator is established.

1.5 Essential Performance

The main clinical performance of the CLARUS 500 is to capture,
display and store images to aid in the diagnosis and monitoring of
diseases and disorders occurring in the retina, ocular surface and
visible adnexa. Since there is are no surgical or treatment decisions
made solely on data obtained by the instrument, it was determined
that the CLARUS 500 has no “essential performance” as defined in
IEC 60601-1 standard.

1.6 Electromagnetic Compatibility (EMC)

Installing or putting the device into service without regard to
EMC information provided

/A WARNING!

may void your Device warranty, result in damage to the instrument
and/or compromise safety for patients and operators.

» CLARUS 500 has special EMC precaution requirements and
needs to be installed and put into service according to the EMC
information provided herein.

NOTE The emissions characteristics of this equipment
make it suitable for use in industrial areas and hospitals (CISPR 11
Class A).
» Ifitis used in a residential environment, this equipment might

not offer adequate protection to radio-frequency communi-
cation services.

» The user might need to take mitigation measures, such as
relocating or re-orienting the equipment.
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1.6.1

1.6.2

1.6 Electromagnetic Compatibility (EMC)

Electromagnetic Emissions [ 19] and Electromagnetic Immunity
[ 19] are required per IEC 60601-1-2:2007.

Electromagnetic Emissions

The CLARUS 500 complies with the following emission require-

ments:

Conducted and radiated RF
emissions

Group 1
CISPR 11 Class A

Harmonic distortion

IEC 61000-3-2

Voltage fluctuations and flicker

IEC 61000-3-3 Class A

Table 1: Electromagnetic Emissions

Electromagnetic Immunity

The CLARUS 500 complies with the following immunity require-

by RF fields

ments:
Electrostatic Discharge IEC 61000-4-2 + 8 kV contact
+ 2 kV, £4kV, £8kV, + 15 kV air
Radiated RF EM fields IEC 61000-4-3 3 V/m
80 MHz - 2,7 GHz
80 % AM at 1 kHz
Proximity fields from RF wireless IEC 61000-4-3 See Wireless Communications
communications equipment [ 20]
Rated power frequency magnetic | IEC 61000-4-8 30 A/m
fields 50 Hz or 60 Hz
Electrical fast transients / bursts IEC 61000-4-4 + 2 kV 100 kHz repetition
frequency
Surges line-to-line IEC 61000-4-5 +0,5kV, £1kV
Surges line-to-ground IEC 61000-4-5 +0,5kV, = 1kV, £2kV
Conducted disturbances induced IEC 61000-4-6 3V

0,15 MHz — 80 MHz

6 Vin ISM bands

between 0,15 MHz and 80 MHz
80 % AM at 1 kHz

2660021165005 Rev. B 2017-10
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Voltage dips, short interruptions,
and voltage variations on power
supply input lines

IEC 61000-4-11

0 % UT"; 0,5 cycle
At 0°, 45°, 90°, 135°, 180°, 225°,
270° and 315°

0% UT'; 1 cycle

and

70 % UT'; 25/30 cycles
Single phase: at 0°

Voltage Interruptions

IEC 61000-4-11

0 % UT'"; 250/300 cycle

Table 2: Electomagnetic Immunity

'UT is the a.c. mains voltage prior to application of the test level.

1.7 Wireless Communications

385 380 - 390 TERTRA 400 | Pulse 18 Hz 1.8 0.3 27
450 430 - 470 GMRS 460, FM + 5 kHz 2 0.3 28
FRS 460 deviation
1 kHz sine
710 704 - 787 LTE Band 13, | Pulse 217 Hz | 0.2 0.3 9
745 17
780
810 800 - 960 GSM Pulse 18 Hz 2 0.3 28
870 800/900,
930 TETRA 800,
iDEN 820,
CDMA 850,
LTE Band 5
1720 1700 - 1990 | GSM 1800; Pulse 217 Hz | 2 0.3 28
1845 CDMA 1900;
1970 GSM 1900;
DECT; LTE
Band
1,3,4,25;
UMTS
2450 2400 - 2570 | Bluetooth, Pulse 217 Hz | 2 0.3 28
WLAN,
802.11 b/g/n,
RFID 2450,
LTE Band 7
5240 5100 - 5800 | WLAN Pulse 217 Hz | 0.2 0.3 9
5500 802.11 a/n
5785

Table 3: Test specifications for enclosure port immunity to RF wireless communications equipment.
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2.1

2.1.1

2.2

2.3

2.3.1

2.3.2

2.3.2.1

2.1 Scope

Introduction

Scope

Intended Use / Indications for Use

The CLARUS ophthalmic camera is intended to capture, display,
annotate and store images to aid in the diagnosis and monitoring
of diseases and disorders occurring in the retina, ocular surface and
visible adnexa, as well as manual measurement of the retina. It
provides true color, infrared reflectance and autofluorescence
imaging modes for stereo, widefield, ultra-widefield, and montage
fields of view.

Usage

The CLARUS 500 is designed for continuous use in a professional
healthcare facility environment.

The mode of operation for the table is 2 minutes on and 20
minutes off.

Intended Audience

CLARUS 500 users have a role, which is assigned when an Admin-
istrator creates their username and password. These roles are:

m Operator

m Doctor

m Administrator

For more information, refer to: About User Roles [ 58].

Patient Profile

This device may be used on any patient who is able to sit upright
with his or her face in the instrument's chin and forehead rest,
independently or with assistance.

Operator Profile

Intended Demographic

This device is intended for use by the following trained profes-
sionals:

m Opticians

m Ophthalmic Photographers
m Optometrists

m Ophthalmologists

2660021165005 Rev. B 2017-10
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2.3.2.2

2.3.3

2.3.3.1

2.3.3.2

2.3.4

2.3.4.1
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m Medical Assistants

m Clinical Researchers

Required Skills

Operators are expected to have the following skills:
= Knowledge of how to capture fundus images
m Experience managing patients

m Experience with the Microsoft Windows operating system and
applications based on it

Doctor Profile

Intended Demographic

Doctors are ophthalmologisst, optometrists, or other heath care
professionals with training in interpretation of fundus images.

Required Skills
Doctors are expected to know how to evaluate fundus images.

Administrator Profile

Intended Demographic

Administrators maintain the facility's computers, instruments, and
networks.

Required Skills
Administrators are expected to know:
m \Windows administration principles
m Networking principles
m Data management principles
m Permissions and user assignment principles
m The site or facility systems, including:
— Network(s)
— Computers and connections
— Medical record system connections

— Instrument connections

22/182
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2.4

2.4.1

2.4.2

2.4.3

2.5

2.6

2.6.1

2.4 User Documentation
User Documentation

Purpose

The user documentation that comes with your device is provided to
ensure that all users operate and maintain it safely and successfully.

m Read all user documentation before starting and using the
device

m Keep all user documentation where it is accessible at all times
for all users

m Pass the user documentation on to the next owner of the
device

Access

User documentation for your device is provided on the USB drive
that came with the device as part of the Instrument Accessory Kit.

Conventions Used in This Document

Certain types of information are specially marked in this document
for better recognition.

m This is a list.
— This is a second level list.
This is a cross-reference: Questions and comments [ 23].
This is software code or program text.

The name of software windows are Capitalized. For example:
"Patient Screen”

Names of menus, and buttons or other selectable items, are shown
in Bold.

m View menu.
m File > Save as
= My documents > Documents

Questions and Comments

If you have questions or comments about this user documentation
or the device, contact your ZEISS representative.

System Overview

System Description

CLARUS 500 is a non-contact, high-resolution imaging device for in
vivo imaging of the human eye. Imaging modes include:

2660021165005 Rev. B 2017-10
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True color reflectance imaging

Infrared reflectance imaging (IR)

Fundus autofluorescence with green or blue excitation (FAF-G
and FAF-B)

Stereo imaging

External eye imaging

Principles of Operation

Using a monochromatic camera, a broad line of illumination scans
across the retina.

Red, green and blue Light Emitting Diodes (LEDs) sequentially
iluminate to generate true color images. The broad bandwidth of
LEDs gives a true color rendering. Blue and green LED illumination
enables Fundus AutoFlourescence (FAF) imaging.

By illuminating only a narrow strip of the retina at a time, the
illumination stays out of the viewing path, keeping haze and
fluorescence of the anterior segment out of the retinal image and
allowing a clear view of much more of the retina than the annular-
ring illumination used in traditional fundus cameras. The design
allows a single exposure to image an area of the retina previously
covered by the 7-fields in the Early Rreatment of Diabetic
Retinopathy Study (ETDRS).

Key Features
Scan Type Options:

m True color

Infrared reflectance (IR)

Fundus autofluorescence with green excitation
Fundus autofluorescence with blue excitation

Stereo imaging

External eye imaging
Field of View Options:

m Widefield: A single image with a 133° FOV when measured
from the center of the eye.

(90° when measured as described in ISO 10940).

m Ultra-widefield: Two images stitched together into a montage
with a 200° FOV when measured from the center of the eye.

(135° when measured as described in ISO 10940).
m AutoMontage: a 4-scan montage using preset fixation targets.

m Montage: 2-6 widefield images stitched into a single,
combined retina image.

247182
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2.6.2 Hardware Overview

The CLARUS 500 is connected to the All-in-One PC using cables
mounted under the table. The operator controls the instrument and
software using the instrument joystick, the All-in-One PC touch-
screen, wireless keyboard and touchpad.

2.6.2.1 System Hardware

Figure 1: System Hardware

1 CLARUS 500 Acquisition 2 | All-in-One PC
Head

3 | Keyboard Tray 4 | Touchpad

5 | Keyboard 6 | Joystick
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2.6.2.1.1 USB Locations

Figure 2: USB Port Locations (6 total)

—_

USB 2.0 2 Side

N

USB 3.0 4 Bottom
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2.6.2.2 Patient View

Figure 3: Patient View

2.6 System Overview

il

1

Forehead rest

Helps keep the patient's head steady and in
place

2 | Front lens Aperture for image acquisition
3 | Chin rest Positions the patient's head at the correct
height
4 | Chin rest Manually raises and lowers the chin rest
adjuster

2660021165005 Rev. B 2017-10
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2.6.2.3 Operator Controls

ol
(LARLS

Figure 4: Operator Controls

1 | Focus knob Manually adjusts the focus

2 | Friction knob Tightens or loosens the swivel movement of the
acquisition head

3 | Joystick Moves the acquisition head side-to-side and
forward and back

(The joystick button triggers image capture)

4 | Cross-table lock | Locks the lateral movement of the acquisition
head

287182 2660021165005 Rev. B 2017-10



Instructions for Use

2 Introduction

2660021165005_Rev_B

2.6 System Overview

2.6.2.4 External Fixation Target

Figure 5: Installing the External Fixation Target

1

External Fixation | Used when patient cannot see the internal
Target fixation target

External Fixation | Mount for the external fixation target
Target Mount

Patient Support | Support for the headrest and chinrest

2.6.3 Software Overview

The CLARUS 500 software includes three distinct areas: Patient,
Acquire, and Analyze windows. All windows use the same top

toolbar.

2.6.3.1 Main Toolbar

Patient > Acquire

2 3 4 5 6

Figure 6: Main Toolbar

1 it s | Indicates your current screen:

m Patient
m Patient > Acquire
m Patient > Analyze

Quickly hides the screen for patient privacy

2660021165005 Rev. B 2017-10
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Opens notification volume control

N
2 E

Opens the Settings to configure the instrument and set your
preferences

Minimizes the application on the computer's desktop

Ul

Allows you to log off or shut down

2.6.3.2 Patient Window
Use the Patient window to find, edit, and add patient records.

1 2
o " Davidson, Jeff
bale 01713198324 DOR 7221957 E

—— Rafractive Errod

Spleve

3/24/1907 oD 150 100 110
115 050 120
B19/1945
Q01943 Eye Color
Clastillo, Johnr Eve Color -
1|13150449 107251990 B i from
C|lark, Sam
1| 1a484 300 8171951
History
Flrrguson, Cor|nit
(13197905 1/25/1936
Fermandez, Birt
113128083 8/11/1958
t?lma‘s,.?ll.rﬂln Analyze | Acqul'ﬂ*\ l
9 8 7 6 5
Figure 7: Patient Window
1 Search field Searches for a patient record by patient name, ID, or date of birth
2 Advanced Opens the Advanced search, which allows a more detailed search
3 Add Allows you to create a new patient record
4 Patient data Displays data about the selected patient
5 Acquire Opens the Acquire window allowing you to acquire new scans for
the selected patient
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6 Analyze Opens the Analyze window allowing you to analyze scans and
prepare reports

7 History Lists the selected patient's scans from prior visits
8 All Lists patient records available on the local database
9 Today Lists patient records for the patients scheduled today

2.6.3.3 Acquire Window

Use the Acquire window to set image capture options and capture
images.

1 2 3 4 5 6

Srmith. John

14 13 12 1 10 9 8 7

Figure 8: Acquire Window

1 Patient data Information about the currently selected patient

2 Laterality Indicates which eye is being captured

3 Alignment preview A visual aid for aligning the instrument to the patient's pupil

4 Live preview Displays a real-time preview image prior to capture and a quality

check image following capture

5 Thumbnail filters Filters the capture bin by laterality or scan type
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6 Capture bin Displays thumbnails of images that have already been captured, along
with the capture settings

7 Analyze Opens the Analyze window

8 Focus Displays the current focus and allows for manual focus adjustments.
Auto determines the best focus setting automatically.

9 Blink internal fixation Blinks the internal fixation target for a configurable amount of time

target

10 Capture Captures the image

11 Scan Type Sets the type of scan

12 Pupil Size Toggles between mydriatic and non-mydriatic acquisition modes

13 Fixation Type Toggles between internal fixation and external fixation targets

14 Patients Returns to the Patients window

2.6.3.4 Analyze Window - Proof

The Analyze window has two screens:
m Proof to view and select images
m Review to compare and edit images

32/182
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12

Figure 9: Analyze Window - Proof

11 10 9

Patient data

Displays information about the currently selected patient

2 Favorite Flags selected thumbnails with a yellow start for easy identifiication

3 Laterality filter Allows you to filter the thumbnails to show one or both eyes

4 Date filters Allows you to filter the thumbnails to show only those taken between
the start date and end date you set

5 Scan type filter Allows you to select which type(s) of scans to show

6 View Allows you to select what size to display the thumbnails in preview

7 Sort Allows you to group the thumbnails by scan type or laterality or show
thumbnails in the order they were taken (Date/Time)

8 Clear Remove all thumbnails from the Selection bin

9 Review Opens the Review screen for viewing and editing the images in the
Selection bin

10 Selection bin Displays thumbnails of selected images

11 Preview Displays available thumbnails as filtered

12 Patients Returns to the Patient window

2660021165005 Rev. B 2017-10
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2.6.3.5 Analyze Window - Review
3 4 5 6 7 8 9 10 11

15 14 13 12
Figure 10: Analyze Window - Review

1 Patient data Provides information about the selected patient

2 Number of viewports Controls how many viewports are in the main display area

3 Zoom Opens the zoom slider

4 Annotate Opens the annotation tool panel

5 Adjust image Opens the brightness, contrast, saturation, and sharpness sliders

6 Rotate Rotates the image 180°

7 Save Saves the edited image

8 Print Report Opens a preview of the report to print

9 Montage Allows you to select and create a montage

10 Stereo Displays linked, side-by-side view of stereo image pairs

11 Sort Selection Allows you to select the way to sort the selected scans

12 Proof Returns to the Proofsheet

13 Selection bin Displays thumbnails of the selected images

14 Viewport Allows you to see the selected images.
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15 Patients

Returns to the Patient window

2.6.4 Networking Overview

/A WARNING!

/A WARNING!

CLARUS 500 can run as a standalone instrument storing patient
and exam data locally, or it can be connected to a network server
or EMR system to share data and worklists in a central location.

Adding peripheral equipment

may result in noncompliance with the safety requirements of IEC
60601-1.

» You are responsible for ensuring that the system meets the
safety requirements of IEC60601-1.

» Place any AC-powered, non-medical device peripherals at least
1.5 m away from the device and connect them to a separation
device, or else use an isolation transformer.

Connection to It-Networks including other equipment

could result in previously unidentified risks related to patients,
operators or third parties.

Changes to the IT networks could introduce new risks that require
additional analysis.

Changes to the IT networks include:
» Changes to network configurations
» Connections of additional items
» Disconnection of items
» Update of equipment
» Upgrade of equipment

v" The Responsible Organization should identify, analyze, evaluate
and control these risks.

2660021165005 Rev. B 2017-10
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3

3.1
/A WARNING!
/A WARNING!
A\ CAUTION!

3.1.1

3.1 Hardware Installation

Installation

Hardware Installation

Your instrument will be installed by qualified ZEISS representatives.
Do not attempt to install the instrument yourself.

Unauthorized Installation

Unauthorized installation could lead to the injury of patients and
operators, as well as to property damage.

» Only ZEISS authorized personnel may install Zeiss products.

Powering peripherals directly through a wall socket
could result in electrical shock to the patient and/or examiner.

» When using a printer in the USB configuration, always power
the printer through an isolation transformer. Some ZEISS
equipment comes with an isolation transformer that may be
used by plugging into a special power strip provided with the
equipment. Talk to your ZEISS Service Representative to
determine if this is true for your equipment.

» If you are not sure, plug all peripherals (such as a printer), into
an isolation transformer. This requires a special power cable. In
North America, the required cable has an IEC-320-14
connector on one end and a NEMA S—15R connector on the
other end. This cable is included in the accessory kit shipped
with the instrument.

Do not lift or carry the instrument using the patient support.
The patient support could break if used as a carrying handle.

» Make sure you support the instrument from the base whenever
you carry the instrument.

Preparing to Install

Install the CLARUS 500 instrument in an environment that meets
the following requirements:

m no direct sunlight

m properly grounded, dedicated 15 A power source that meets all
local electrical codes

m not connected to a power strip
m the device's ventilation openings are not blocked
m the device is not exposed to water or other liquids
Do not modify the instrument or use cables not provided by ZEISS.

2660021165005 Rev. B 2017-10
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The CLARUS 500 instrument arrives on a pallet with three boxes
that contain all parts and accessories needed to assemble the
instrument and table.

Software Installation

The CLARUS 500 system ships with software installed on your
instrument. From time to time you will be notified to upgrade
system software (Upgrading Instrument and Review Software
[ 41]).

You can install review software on any compatible laptop or
computer that clinicians use to review scanned images (Installing
Review Software [ 38]).

Installing Review Software

You can install review software on computers that clinicians use to
compare, analyze, annotate and save scans acquired on CLARUS
500.

NOTE

If you need to uninstall review software, use the Windows
control panel for adding and removing programs.

The computer must meet the following minimum requirements:
m Runs on:
— Windows 7
Windows 8
Windows 10
Windows 2008 Server R2
Windows 2012 Server R2

m Has an Intel processor with a Passmark benchmark score of at
least 5675

m Has at least 8 GB of memory

® Has a monitor with resolution set to at least 1024 x 768

Review software does not support: adding, editing, or
deleting a patient record.

Adding, editing, or deleting a patient record
Deleting a scan

Adding users or user accounts

Adding, editing, or deleting the Institution data

To install review software:

M The computer and monitor meet the minimum requirements
listed above.

387182
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1. Insert the software media into the review station computer's
USB drive.

2. In the CLARUS 500 software folder, double-click on
setup.exe.

= A confirmation opens.
3. Click Next.
4. Accept the license agreement, then click Next.

License Agreement

Please read the following license agreement carefully.

@) I accept the terms in the license agreement

(7 I do not accept the terms in the license agreement

InstallShield

5. Type the user name and organization name and click Next.

6. Select Review Software, then click Next.
) CLARUS - InstallShield Wizard S -

Remote Desktop Services Mode

Please Select your choice

Please select a Machine type.
@ Review Software

All program features will be installed. (Requires the most disk
space.)

All program features will be installed. (Reguires the most disk
space.)

Installshield

[ « Back ]{ Mext > I ’ Cancel ]

7. If you want to choose a different destination folder for the
review software, click Change... and browse to the desired
folder.
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ﬁ CLARUS - InstallShield Wizard

Destination Folder
Choose Data Directory for CLARLUS:

Install CLARUS to:

C:\ProgramData\Carl Zeiss Meditec\Review),

Installshield

[ <Bak || nNext> || cancal

8. Click Next.

9. If this review software will use Remote Destop Services, check
Remote Desktop services will be used.

4] CLARUS - InstallShield Wizard (= B X

Remote Desktop Services Mode

Remote Desktop Services

Remote Desktop Services in Windows Server 2008 R2 and Windows Server 2012
R2, formerly known as Terminal Services in Windows Server 2008 and previous
versions, is one of the components of Microsoft Windows (Both server and dient
versions) that allows a user to access application and data on a remote computer
over a network, using the Remote Desktop Protocol (ROP)

Remote Desktop services will be used

| InstallShield
|

<Back || Next> || Cancel

10. Click Next.
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#) CLARUS - InstaliShield Wizard (= B X

Ready to Install the Program

The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

| InstallShield

[ <Bak |[ Himstal || cancel

11. Click Install.

12.1f your system prompts you to confirm changes on the
computer, click Yes.

= Review software installation begins. Installation takes
several mintues to complete.
13. When installation is complete, click Finish.
14 CLARUS - InstallShield Wizard ——m = =S

T .

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed CLARUS.
Click Finish to exit the wizard.

« Back . Cancel

Result v" Installation completes and the configuration wizard opens.
For more information about the configuration wizard, refer
to: Setting All Options [ 46].

3.2.2 Upgrading Instrument and Review Software
Prerequisite M Settings are open (Opening Settings [ 45]).
Action 1. Select the Maintenance tab.
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2. Under Update, click Start Update....

| — o -
——— -
v P
s m— —
- frma
e -
1
—
—-—
Bk

= A confirmation opens.
3. Click Yes.
Result v" The software installs and the system reboots.

When you upgrade instrument or review software, CLARUS 500
retains stored information including:

m Logins and Passwords
m Patient Data
m Exam Data
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4.1

A CAUTION!

4.1 Turn on the Instrument
Daily Startup

Turn on the Instrument

Do not unplug the instrument during startup
or instrument may not start up successfully.

» Make sure the instrument has completed its system checks
before you unplug or remove power.

Each time you turn on the CLARUS 500, system diagnostics checks
that the system initialized correctly and is running properly. If the
diagnostic check detects any problems, an error or alert message
displays. For more information about startup errors and alerts, refer
to: Troubleshooting [+ 145].

NOTE

Action

If a critical system test fails
take the device out of service.
» Contact your ZEISS representative.

» If a non-critical test fails or a warning appears, the device can
still be used. Contact your ZEISS representative. (See Mainte-
nance [ 143].)

To turn on the instrument:

1. Turn on the instrument (green switch).
2. When the system test sequence completes, click Continue.
3. Log in (Logging In [ 44]).

= The Patient window displays.

2660021165005 Rev. B 2017-10

437182



4 Daily Startup Instructions for Use
4.2 Logging In 2660021165005_Rev_B

4.2 Logging In

After the system boots up and runs a series of system checks, the
login screen opens. The login screen also appears when a user logs
out.

NOTE Passwords are case-sensitive.
An Administrator must add a user's name and password

before that user can log in. (Adding a New User [ 58])

To log in:

Action . o
1. Double-click on the CLARUS 500 application icon.

= The login screen opens.
2. Select your user name.

3. Type your password.
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5 Configuration

5.1 Opening Settings

5.1 Opening Settings

The Settings icon is on the top toolbar of all application windows.
You can open settings from any screen in the application.

Setting options allows you to configure the application the way you
want to use it. Different types of users can set different options. For
more information about settings permissions, refer to: About User

Roles [ 58].

System Information

Instrument and software information

General Settings

Your institution information
Duration for displaying alerts
Local date, time, and language
Teleservice

On-screen keyboard

Patient ID creation

Printer and reports

Specific Settings

Acquisition settings

Capture preview duration
Fixation target blink duration

Scan type presets

Import and Export Settings (DICOM and FORUM)

Networking

Network connection settings

Maintenance

Record backup and restore
Application update

Log files

Factory reset

User Management

Create, edit, and delete users

Change password

Licenses

View, activate, repair, and return licensed
features

Table 4: Settings

=

Action
Result

To open settings:

1. Click on the Settings icon on the toolbar.

v The Settings window opens.

2660021165005 Rev. B 2017-10
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5.2 Setting All Options

CLARUS 500 has an initial settings wizrds that you can also use for
checking or resetting options.

NOTE Only Administrators can complete this task.

To set all options using the wizard:

Prerequisite M Settings are open (Opening Settings [ 45]).
Action 1. Select Maintenance and click Run Wizard.

= The initial settings wizard opens and steps you through
settings.

5.3 Managing Data

5.3.1 Manage Patient Records

When patient records are imported from an EMR, they are recon-
ciled with local records as follows:

m Same ID and Issuer of ID, different name, date of birth, or
gender: The local record is updated to match the EMR record.

m Different ID or Issuer of ID: A new patient record is generated.

Some EMR systems allow records that are missing key identifying
information. The CLARUS 500 automatically adds the default
"Unknown" if the name is missing, but rejects records that do not
have a Patient ID or date of birth.

5.3.1.1 Adding a Patient
Adding the patient's name and date of birth are both required.

To add a patient:
Prerequisite M The Patient window is open.
Action 1. Click Add.
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. Type the patient's first and last name.

. Select the patient's gender.

. Select the patient's date of birth.

. (Optional) Type the patient's Refractive Error information.
. (Optional) Select the patient's Eye Color (optional).

. To acquire a scan, click Acquire.

N oo N

5.3.1.2 Merging Patient Records

Action

If two records are inadvertently created for the same patient, they
can be merged to store all the patient data in one record.

To merge patient records:

1. In the Patient window, select the patient name and click on
the down arrow.
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2. Select Merge.

3. Type the name or ID for the duplicate patient record in the
search field and click Search.
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4. Select the duplicate patient record(s). You can merge up to 20
patient records.

5. To see the details of selected patient records side by side with
the original record, select Compare.

6. Select Merge.

Please enter the merge reason

Duplicate Patient Entry

Use this text as default merge reason

Cancel Merge

7. Enter a reason for the merge, then select Merge again.

= The exam data from the duplicate patient record is added
to the original patient record.

5.3.1.3 Reassigning Image Scan

If you inadvertently select the wrong patient record at the
beginning of an exam, you can reassign the data to the correct
patient record.

To reassign test data:
Prerequisite M Settings are open (Opening Settings [ 45]).

M The patient with incorrect test data is selected Search for a
Patient Record.

Action 1. Click the down arrow for the patient with test data that you
want to reassign.
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2. Select Tests.
= A list of the tests assigned to the patient opens.

3. Select the incorrectly saved test and click Reassign.
= The Reassign page opens.

Wiz, Cossrmeasy 1
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4. In the search field, type the name, ID number, or DOB of the
patient the test data belongs to and click the search icon.
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5. Select the correct patient and click 2660021167882 Rev. A.pdf.
= A confirmation opens.

Please enter the readsign reason

Oiperator sedectid the wrong patient prioe 10 the Test,
Moving test data 1o the cormect patient file.,

Lige this teat &5 default reassign reason

Cancel Reassign

6. Type a reason for resassigning the test.
7. Click Reassign.

5.3.1.4 Deleting a Patient Record

Only Administrators can complete this task.
NOTE y P

Patients deleted on the instrument are not deleted from the EMR
system.

To delete a patient record:

Prerequisite M The instrument is not connected to FORUM or any other EMR
system.
Action 1. In the Patient window, select the patient name and click on

the down arrow and select Delete.
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= A confirmation opens.
2. Click Delete.

5.3.1.5 Manually Correcting Laterality

You can change the laterality of an image after it is saved using the
Review or Proof screen.

Laterality change feature does not work under the following condi-
tions:

m After the data is exported
® In connected mode (FORUM)
m On imported data

To correct laterality manually in Proof:
M Proof Sheet is open.
1. Right-click on the image you want to change.

2. Select Change Laterality.
= A confirmation opens.
3. Click OK.
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Result v" The thumbnail changes laterality.

To correct laterality manually in Review:
Prerequisite M Review is open.
4. Select the image you want to change.
5. Click on the current laterality indicator in the preview panel.
= The other laterality appears for selection.

1

d

6. Click the desired laterality.
= The laterality indicator changes.
7. Click Save.

5.3.1.6 Importing Data

You can import data in the following individual exams or multiple
exams (bulk import).

You can import the following file formats:
= JPG
m TIFF
m PNG

JPEG2000

DICOM

ZIP (compressed)

To import data:
Prerequisite M Settings are open (Opening Settings [ 45]).
Action 1. Insert the removable media into the USB port.
2. Click Specific Settings.
= The Specific Settings window opens.
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3. Click Import.

b

4. Click Import... and navigate to the file stored on the external
removable media device.

5. Click Select.
= A confirmation informs you when the import completes.
6. Click OK.

5.3.1.6.1 Data Integrity of Imported Records

For all imported patient records, it is possible to import new scan
data and update patient data, including obscured patient records. If
during import the device encounters information associated with a
patient that was already imported, the device does the following:

m imports all scan data (exams) not previously imported, but never
deletes nor overwrites any scan data already imported

m updates patient data only if it was created on a later date than
the data already imported. This prevents overwriting of newer
patient data with older patient data

5.3.1.7 Exporting Data
You can export data in multiple ways:
m |In the Proof or Review screen, select an image and right-click.
m |n the Proof screen, select multiple images and right-click.
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m Export all of a patient's data; select Settings > Specific
Settings > Export.

m Set automatic export (Configuring Import and Export)

To export data:
M Settings are open (Opening Settings [ 45]).

1. If you are exporting to removable media, insert the media into
the USB port.

2. Click Specific Settings.
= The Specific Settings window opens.
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3. Click Export.
= A list of all patients opens.

¥ Fuprsit

4. Check the patients you want to export and click Export.
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5. Navigate to the folder you want to use for export and click
Select.

= A progress bar appears until export is complete.
6. Click OK.

= The data exports and a confirmation opens.
7. Click OK.

5.3.1.8 Configuring Import Settings

You can choose automatic import of images and data from a
folder.

NOTE If you use an EMR system, make sure you complete the
networking settings

to ensure that automatic export can connect to your EMR server.

To configure import settings:

Prerequisite M Settings are open (Opening Settings [ 45]).
M A folder for automatic imports is created and you know the
path to it.
Action 1. Select Specific Settings.
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2. Click Import Export Settings.
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Under File import, set Auto import files to On.

Click Browse... and navigate to the folder to use for automatic
importing.
Click Select.

v" The folder path appears next to the Browse.... button and
files stored in that location will be automatically imported.

5.3.1.9 Configuring Export Settings

You can choose automatic exporting of images and data settings,
including:

How often to automatically export images and patient data
whenever a user either:

What type of EMR server to send the exported images and data
and the server path

What image format to use for export
What report format to use for export
Whether to compress files on export

Whether to removes patient demographic information from
exported exam data

NOTE If you use an EMR system, make sure you complete the
networking settings

to ensure that automatic export can connect to your EMR server.

To configure export settings:

Prerequisite M Settings are open (Opening Settings [ 45]).

Action 1.

Select Specific Settings.
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2. Click Import Export Settings.
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3. Set the frequency of automatic exports:
To set automatic export when a user logs off, click Session.
To set automatic export when a user shuts down the ZEISS
application, click Shutdown.

4. If you use and EMR system, select the type (FORUM/PACS or
DICOM).

5. Under File Export, select the file format for images (DICOM,
JPEG, PNG, TIFF, JPEG2000).

6. To automatically removes patient demographic information
from exported exam data, set De-identify patient data to On.

7. To automatically compress data on export, set Compress Data
to On.

8. For Report Export, select whether to use PDF, ePDF or both
formats.

5.3.2 Manage Users

Do not use Bitlocker Passkeys with this instrument or review
1?3 1
CAUTION! software.
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Unsecured Logins
NOTE ogms | |
may result in unauthorized access or inaccurate record-keeping.

» Create individual user accounts for each staff member.

» Staff members should log out after every use.

5.3.2.1 About User Roles

Not all users have access to all features. The table below list some
of the key differences for different types of users.

Acquire scans

Review scans

Select, edit and annotate scans

Use review software installed on a separate computer

Reset your own password

Delete a local patient record

Save and print reports

Import and export data

X | X | X | X | X | X | X| X | X

Configure import and export settings

X | X | X | X | X | X | X | X | X]|X

Configure general settings

Configure network settings

Configure data backup

Restore data from a backup

Perform system maintenance

Manage licenses

Reset other user's passwords

Add or delete users

X | X | X | X | X | X| X | X | X| X|X|X| X]|X

Export log files

Table 5: Permissions Levels

5.3.2.2 Adding a New User

Only Administrators can complete this task.
NOTE y P

For valid password format, see: Password Requirements [ 61].
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To add a new user:
Prerequisite M Settings are open (Opening Settings [ 45]).

Action 1. Click Settings > User Management.
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2. Click Add User.

|

'IIJH

3. Type the information for the new user and select the user's
role.

4. Click Add User.
Result v' The new user can now log in.

5.3.2.3 Deleting a User

Only Administrators can complete this task.
NOTE y P

To delete a user:

Prerequisite M Settings are open (Opening Settings [ 45]).

Action 1. Click Settings > User Management.
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2. Select the Login name for the user you want to delete.
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3. Click Delete User.

v" The user's Login is now disabled.

5.3.2.4 Changing a User's Password

Only Administrators can complete this task.
NOTE y P

Prerequisite
Action

Result

Prerequisite

For valid password format, see: (Password Requirements [ 61])

To change a user's password:
M Settings are open (Opening Settings [ 45]).
1. Select User Management.

2. Select the Login name for the user who needs a new
password and click Change Password ....

i

= The password reset panel opens.

User name jmason

New password

Repeat new password

Cancel Reset password

3. For New password, type a new password for the user.
4. For Repeat new password, retype the new password.
v The new password for the user is now active.

5.3.2.5 Changing Your Own Password

For valid password format, see: (Password Requirements [ 61])

To change your password:
M Settings are open (Opening Settings [ 45]).
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Action 1. Click Settings > User Management.
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2. Click Change Password ....

3. For Old password, type your existing password.

4. For New password, type a new password.

5. For Repeat new password, retype the new password.
Result v" Your password is now changed to the new password.

5.3.2.6 Password Requirements

CLARUS 500 users’ passwords expire every 60 days. All passwords
must follow these rules:

m Must be at least seven characters long.

m Must contain at least three of the following:

English uppercase characters (A through 2)

English lowercase characters (a through 2z)
Numbers (0 through 9)

Non-alphabetic characters (for example: !, S, #, %)
m Must not contain the user's account name.

m Must not contain two consecutive letters of the user's name.

5.3.3 Manage Backups

On the CLARUS 500, you can enable data backup each time the
system shuts down (Configuring Automatic Backups [ 62]). You
can also back up data manually at any time (Backing Up Data
Manually [ 62]).
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5.3.3.1 Configuring Automatic Backups

You can save a backup copy of selected data at any time. You can

save this data on removable media for import into other applica-
tions.

To configure automatic backups:
M Settings are open (Opening Settings [ 45]).
Action 1. Insert the removable media into the USB port.
2. Click Settings > Maintenance.

Prerequisite

= The Maintenance window opens.

i1

3. Slide Data backup on Shutdown to Backup Enabled.
4. Click Browse.

5. Navigate to the folder where you want to store the backups
and click Select.

Result v' Each time the system shuts down a backup will be saved in

the selected folder.

5.3.3.2 Backing Up Data Manually

To back up data manually:

Prerequisite M Settings are open (Opening Settings [ 45]).
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Action 1. Insert the removable media into the USB port.
2. Click Settings > Maintenance.
= The Maintenance window opens.

i1

3. Click Backup Now.

= A progress bar opens.

= When the backup completes, a confirmation opens.
4. Click OK.

Result v A new data backup is stored in the folder you configured to
store automatic backups. (See Configuring Automatic
Backups [ 62].)

5.3.3.3 Restoring Data from a Backup

Only Administrators can complete this task.
NOTE y P

If the CLARUS 500 has automatic backups enabled or if there is a
saved manual backup, you can restore the system with the data
from the backup file.

After you restore data, you must restart the instrument.

To restore data from a backup:
Prerequisite M Settings are open (Opening Settings [ 45]).
Action 1. Select Maintenance.
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2. Under Data Restore, select the backup you want to install.
3. Click Replace.

= A confirmation opens.
4. Click Replace.

= A progress bar opens. When restoration is complete, a
restart confirmation opens.

5. Click Restart.
Result v' The system restarts with the data that existed in the backup.

5.3.4 Log Files

CLARUS 500 records the following events and identifies them by
date, time, and User ID:

m Log on/log off

m Create, modify, delete data

m Import/export data from removable media
m Receipt/transmit data from/to the network
m Remote service activity

A new file is created when the application starts. Events are
automatically recorded in 1-5 audit files of 10 Mb each.

The instrument retains up to 100 of the latest log files. When file
size limit is reached, the device overwrites existing files (starting
with the oldest file).

The default folder for the audit log files is C:\ProgramData\Carl
Zeiss Meditec\...\Logs.
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NOTE Save (export) audit log files regularly
to ensure events of consequence can be tracked should you

encounter a data error.

» Log on as Administrator.

» Click Tools > Export Audit Log File.

» In the Browse folder, browse to the export location.
» Click Save.

= The log is exported as a .zip file with the format:
AuditLog_dd_mm_yyyy _hh_mm.

5.3.5 Data Storage

The CLARUS 500 includes a some storage space on its PC. If you
need additional data storage capacity, add external networked
storage devices as requried.

5.4 Managing Connections

5.4.1 Connecting to a Wireless Printer

Connect only to wireless printers recommended).
NOTE y P )
Only Administrators and Doctors can complete this task.
NOTE y P

To connect to a wireless printer:
Prerequisite M The CLARUS 500 and printer are on.
M The printer is configured correctly.
M Settings are open (Opening Settings [ 45]).
Action 1. Select General Settings and scroll to the bottom.
2. Under Printer and Report, click Manage Printers.

e s
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3. Select the printer you want to connect and click Add Printer.

Prafiter selig

i Fax Add printer
ik HP Uiniversal Printing PCL & oy
i HP Uriversal Printing P e
Properties
Prird test page Close.

4. To print a test page, select the printer and click Print test
page.

5. To view the properties of the printer, click Properties.

5.4.2 Mapping Networked Drives

To map a networked drive:
Prerequisite M Settings are open (Opening Settings [ 45]).

M You know the path of the drive you want to map in the format:
\\<servername>\<foldername>\<subfoldername>. For example:
\\Server x543\ZEISS\Exported Files

Action 1. Select Networking.

I
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. Under Network Drive Configuration, click Map....

Netwaik path  Vigerver aSANITISSExpted Files
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3. Type the path and select the Drive letter.

4. To save the login credentials, type a User name and
Password for the server.

5. Click Map.
Result v' The drive is now mapped.

5.4.3 Connecting to a LAN

To connect to a LAN:

Prerequisite M The CLARUS 500 must be connected to the local network using
a network cable. Be gentle with the connector when plugging
it into the CLARUS 500 ethernet port.

M Settings are open (Opening Settings [ 45]).
Action 1. Select Networking.
- .
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2. To automatically assign an IP address to the instrument, set
DHCP to Enabled. For a network with static IP addresses, set
DHCP to Disabled and enter the relevant network infor-
mation.

3. Under Network Drive Configuration, select Map....

4. Enter the network path for the shared folder you'd like to
connect to. The shared folder must be a root directory or a
subdirectory of a root directory.

5. Select an unused drive letter.

6. If a password is required for access to the shared folder, enter
the username and password. Otherwise, leave these fields
blank.

7. Select Map.

= Successfully mapped drives are indicated with a check mark
in a green circle. To disconnect a network drive, select the
drive, then click Unmap.
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5.5 Configuring Local Settings

Local settings include information about your clinic such as address,
local language and local time zone.

To configure local settings:
Prerequisite M Settings are open (Opening Settings [ 45]).
Action 1. Select General Settings.

2. For Institution Information, complete the form for your clinic.

3. For Alert display time, select the number of seconds you
want system or instrument alerts to display.

4. For Locale Settings, select the language and date formats.
5. Scroll to set additional general settings.
6. For System Date and Time, select the appropriate settings.
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7. To display the onscreen keyboard, slide On-Screen Keyboard
to Enabled.

8. For Patient Management, select Name or ID as patient data
identifier.

9. Select the method for patient ID assignment. If you select
CLARUS 500, the instrument will assign unique IDs for patients.
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5.6 Configuring Report Settings

10. If your language requires Multi-Component Names, Enable
Multi component names and select the appropriate type.

5.6 Configuring Report Settings

You can add your logo and a signature field to reports. You can
also set the path for storing reports and manage printers.

To configure the report settings for automatic export, refer to:
Configuring Export Settings [ 56].

To configure report settings:
Prerequisite M Settings are open (Opening Settings [ 45]).
Action 1. Select General Settings.

2. Scroll to the bottom of the General Settings panel.

(=

3. To enable a signature field on reports, slide Signature field on
reports to Show.

4. To add a logo to reports, click Browse... next to Report logo
and navigate to the logo file and select it.

5. To set a path to store reports, click Browse... next to Report
storage path.

5.7 Configuring Acquisition Settings

You can add your logo and a signature field to reports. You can
also set the path for storing reports and manage printers.

To configure acquisition settings:
Prerequisite M Settings are open (Opening Settings [ 45]).
Action 1. Select Specific Settings.
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5.8 Clearing Alert History

To clear alert history:
M Settings are open (Opening Settings [ 45]).

Prerequisite
1. Select System Information.

Action

2. Under Alert History, click Clear.
= The alerts are removed.
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5.9

5.9 System Administration

System Administration

NOTE

5.9.1

5.9.2

5.9.2.1

5.9.2.2

5.9.2.3

Only Administrators can complete this task.

This section contains detailed configuration information for system
administrators. Only system administrators should make changes to
these settings.

Windows Patches and Updates

Automatic Windows updates are disabled. Windows patches and
updates are distributed with CLARUS 500 software after they are
tested and approved for use.

Data Safety

Auto-lock

After 15 minutes of inactivity, the CLARUS 500 screen locks and the
user must log in again.

Anti-Malware

When configuring anti-malware applications, ensure that updates
and full system scans do not occur when data acquisition could be
in progress. Refer to the software release notes for a list of
approved anti-malware software.

User Names and Passwords

NOTE

Passwords for Tech Support users are unique for each
system.

Zeiss instruments initially have three user names and passwords.
Initial passwords are shown in the table below. Change these
passwords before using the instrument.

Zeiss Administrator Novemberl71846 Instrument User

ZeissAdmin Administrator Novemberl171846 Instrument Adminis-
tration

Technical Support | Administrator <unique> Zeiss Technical Support

Table 6: Initial User Names and Passwords

2660021165005 Rev. B 2017-10
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Networking

Network Controllers and IP Addressing

NOTE

5.9.3.1.1

The CLARUS 500 is not compatible with networks using IPv4
addressing in the range of 192.168.111.0 to
192.168.111.254.

The CLARUS 500 contains two network controllers; Internal
Network and External Network.

Internal Network Ports

NOTE

5.9.3.1.2

5.9.3.2

5.9.3.2.1

Do not rename the Internal Network.

Internal Network is for instrument use only with the following
assignments:

m Static IPv4 address: 192.168.111.2
m Subnet mask: 255.255.255.0

External Network Ports

The External Network is for CLARUS 500 connectivity and
automatically picks up an IP address.

Required Network Ports
The network ports listed in this section are required for proper
operation of the CLARUS 500.
Required Internal Network Ports
m [nternal Communication Port: TCP 80
m Internal Communication Port: TCP 22

5.9.3.2.2 Required External Network Ports
Database inbound 18081
Database outbound 18082
Database inbound/outbound (open port visible externally) 3346
Peer to Peer broadcast inbound/outbound 54183
Distributed Data Service inbound/outbound 54187

Table 7: External Network Ports

5.9.3.2.3 Required External Network Ports for EMR and FORUM
DICOM outbound 11119
FORUM outbound 8080
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DICOM inbound

11112

FORUM inbound

The first available port in this range will be used.

8081 ~
8101

DNS

(AutoConnect for instruments outbound)

5353

Table 8: External Network Ports for EMR / FORUM

5.9.3.3

Additional Network Ports

The following network ports are not required to operate the
instrument. These ports facilitate instrument configuration and
maintenance.

Remote service (outbound) 80

DHCP 67 - 68
TCP/IP MS Networking 445

NTP 123
NETBIOS Name Service 137 137
(UDP open port visible externally)

NETBIOS Datagram Service 138 138
NETBIOS Session Service 139 139

Table 9: Additional Network Ports

594

59.4.1

Configuring Enhanced Security

Enhanced security settings are not required to operate the
instrument properly. You can change these settings individually to
match your Windows installation.

To remove Enhanced Security, log in as ZeissAdmin and run the
“Remove Enhanced Security.CMD"” script located on the desktop.

Disabling Enhanced Security Settings

When you received the CLARUS 500, enhanced security settings are
turned on. These settings are not required for the instrument to
operate properly.

You can change individual settings per your institution's requires or
you can disable all of these settings using the Remove Enhanced
Security command on the desktop.

Enhanced security settings are listed in the following sections:

2660021165005 Rev. B 2017-10
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m Enhanced Security Windows Firewall Rules [+ 74]
m Enhanced Security Services [ 75]
m Enhanced Security Group Policy [ 76]

Only Administrators can complete this task.
NOTE y P

To disable enhanced security settings:
Prerequisite M The CLARUS 500 application is minimized (Main Toolbar [ 29])

Action 1. Location the following command on the Windows desktop:
Remove Enhanced Security.CMD.

2. Double-click Remove Enhanced Security.CMD.

= All enhanced security settings are reset to the Windows
default settings.

5.9.4.2 Enabling Enhanced Security Settings

When you received the CLARUS 500, enhanced security settings are
turned on. These settings are not required for the instrument to
operate properly.

If there were changes to individual settings or if all enhanced
security settinges were disabled () you can re-enable all of these
settings using the Install Enhanced Security command on the
desktop.

Enhanced security settings are listed in the following sections:
m Enhanced Security Windows Firewall Rules [+ 74]
m Enhanced Security Services [ 75]
m Enhanced Security Group Policy [ 76]

Only Administrators can complete this task.
NOTE y Admin P :

To enable enhanced security settings:
Prerequisite M The CLARUS 500 application is minimized (Main Toolbar [ 29])

Action 1. Location the following command on the Windows desktop:
Apply Enhanced Security.CMD.

2. Double-click Apply Enhanced Security.CMD.
= All enhanced security settings are enabled.

5.9.4.3 Enhanced Security Windows Firewall Rules
Enhanced security disables the following Windows firewall rules:
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AllJoyn Router (TCP-In)

AllJoyn Router (TCP-Out)

AllJoyn Router (UDP-In)

AllJoyn Router (UDP-Out)

Cast to Device functionality (gWave-TCP-1In)

Cast to Device functionality (gWave-TCP-Out)

Cast to Device functionality (gWave-UDP-In)

Cast to Device functionality (gWave-UDP-Out)

Cast to Device SSDP Discovery (UDP-In)

Cast to Device streaming server (HTTP-Streaming-In)
Cast to Device streaming server (RTCP-Streaming-In)
Cast to Device streaming server (RTP-Streaming-0Out)
Cast to Device streaming server (RTSP-Streaming-In)
Cast to Device UPnP Events (TCP-In)

Cortana

Delivery Optimization (TCP-In)

Delivery Optimization (UDP-In)

DIAL protocol server (HTTP-In)
Microsoft.AccountsControl

Microsoft.LockApp
Microsoft.Windows.ContentDeliveryManager
Microsoft.Windows.ParentalControls
Microsoft.Windows.Apprep

Network Discovery (WSD Events-In)

Proximity sharing over TCP (TCP sharing-In)

Proximity sharing over TCP (TCP sharing-Out)
Remote Assistance (DCOM-In)

Remote Assistance (PNRP-In)

Remote Assistance (RA Server TCP-In)

Remote Assistance (SSDP TCP-In)

Remote Assistance (SSDP UDP-In)

Remote Assistance (TCP-In)

SmartScreen

Windows.ShellExperience
Windows Spotlight

Wireless Display (TCP-In)

Wireless Display (TCP-Out)

Wireless Display (UDP-Out)

Wireless Display Infrastructure Back Channel (TCP-In)

5.9.4.4 Enhanced Security Services
Enhanced security disables the following services:
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AllJoyn Router Service

Application Layer Gateway Service
Bluetooth Handsfree Service

Bluetooth Support Service

BranchCache

Connected Devices Platform Service
Connected User Experiences and Telenetry
Downloaded Maps Manager

Fax

Function Discovery Resource Publication
Geolocation Service

HomeGroup Listener

HomeGroup Provider

Infrared Monitor Service

Internet Connection Sharing (ICS)
Microsoft iSCSI Initiator Service
Microsoft Storage Spaces SMP

Microsoft Windows SMS Router Service
Network Connection Broker

Phone Service

Program Compatibility Assistant Service
Quality Windows Audio Video Experience
Retail Demo Service

Shell Hardware Detection

Telephony

Touch Keyboard and Handwriting Panel Service
Windows Camera Frame Server

Windows Event Collector

Windows Image Acquisition (WIA)

Windows Insider Service

Windows Media Player Network Sharing Service
Windows Mobile Hotspot Service

Work Folders Xbox Live Auth Manager Xbox Live Game Save Xbox Live
Networking Service

5.9.4.5 Enhanced Security Group Policy

Access Credential Manager as a trusted caller No One

Access this computer from the network Administrators

Account lockout duration ) 60 minute (s

Account lockout threshold 30 invalid logon
attempt (s)

Accounts: Administrator account status Enabled

Accounts: Guest account status Disabled

Accounts: Limit local account use of blank passwords to console logon only Enabled
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Accounts: Rename administrator account ZeissAdmin
Accounts: Rename guest account Not Used
Act as part of the operating system No One

Adjust memory quotas for a process

Administrators,
Local Service,
Network Service

Allow all trusted apps to install Disabled
Allow Basic authentication Disabled
Allow Cortana Disabled
Allow indexing of encrypted files Disabled

Allow log on locally

Administrators,

Users

Allow Microsoft accounts to be optional Enabled
Allow Telemetry 0 - Off (Enterprise Only) Enabled
Allow unencrypted traffic Disabled
Allow user control over installs Disabled
Allow users to connect remotely by using Remote Desktop Services Disabled
Allow Windows to automatically connect to suggested open hotspots, to Disabled
networks shared by contacts, and to hotspots offering paid services

Always install with elevated privileges Disabled
Always prompt for password upon connection Enabled
Apply UAC restrictions to local accounts on network logons Enabled

Audit Policy: Account Logon: Credential Validation

Success and
Failure

Audit Policy: Account Management: Other Account Management Events

Success and
Failure

Audit Policy: Account Management: Security Group Management

Success and
Failure

Audit Policy: Account Management: User Account Management

Success and

Failure
Audit Policy: Detailed Tracking: Process Creation Success
Audit Policy: Logon-Logoff: Account Lockout Success
Audit Policy: Logon-Logoff: Logoff Success

2660021165005 Rev. B 2017-10
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Audit Policy: Logon-Logoff: Logon Success and
Failure
Audit Policy: Logon-Logoff: Special Logon Success
Audit Policy: Object Access: Removable Storage Success and
Failure
Audit Policy: Policy Change: Audit Policy Change Success and
Failure
Audit Policy: Policy Change: Authentication Policy Change Success
Audit Policy: Privilege Use: Sensitive Privilege Use Success and
Failure
Audit Policy: System: IPsec Driver Success and
Failure
Audit Policy: System: Other System Events Success and
Failure
Audit Policy: System: Security State Change Success
Audit Policy: System: Security System Extension Success and
Failure
Audit Policy: System: System Integrity Success and
Failure
Audit: Audit the access of global system objects Disabled
Audit: Audit the use of Backup and Restore privilege Enabled

Audit: Force audit policy subcategory settings (Windows Vista or later) to override | Enabled
audit policy category settings

Audit: Shut down system immediately if unable to log security audits Disabled

Back up files and directories Administrators
Boot-Start Driver Initialization Policy Enabled

Choose the boot-start drivers that can be initialized Good, unknown and

bad but critical

Change the system time LOCAL SERVICE,
Administrators

Configure Automatic Updates Disabled

Configure Offer Remote Assistance Disabled

Configure registry policy processing Enabled

Do not apply during periodic background processing TRUE

Process even if the Group Policy objects have not changed TRUE
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Configure Solicited Remote Assistance
Maximum ticket time (units)
Maximum ticket time (value)

Method for sending email invitations

Permit remote control of this computer

Enabled
Hours

1

Simple MAPI

Allow helpers to
remotely control
the computer

Enabled
Configure Windows SmartScreen Disabled
Create a pagefile Administrators
Create a token object No One

Create global objects

Administrators,
SERVICE, LOCAL
SERVICE, NETWORK
SERVICE

Create permanent shared objects No One
Create symbolic links Administrators
Debug programs Administrators

Deny access to this computer from the network

NT AUTHORITY
\Local
Account, GUESTS

Deny log on locally

Guests

Deny log on through Remote Desktop Services

NT AUTHORITY
\Local
Account, GUESTS

Detect compatibility issues for applications and drivers Enabled
Devices: Allow undock without having to log on Enabled
Disallow Autoplay for non-volume devices Enabled
Disallow Digest authentication Enabled
Disallow WinRM from storing RunAs credentials Enabled
Do not allow drive redirection Enabled
Do not allow passwords to be saved Enabled
Do not display network selection Ul Enabled
Do not enumerate connected users on domain-joined computers Enabled
Do not preserve zone information in file attachments Disabled
Domain member: Digitally encrypt or sign secure channel data (always) Enabled
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Domain member: Digitally encrypt secure channel data (when possible) Enabled
Domain member: Digitally sign secure channel data (when possible) Enabled
Domain member: Disable machine account password changes Disabled
Domain member: Maximum machine account password age 30 day(s)
Domain member: Require strong (Windows 2000 or later) session key Enabled
Don't allow SmartScreen Filter warning overrides Disabled
Enable computer and user accounts to be trusted for delegation No One
Enable insecure guest logons Disabled
Enable local admin password management Enabled
Enable RPC Endpoint Mapper Client Authentication Enabled
Enable screen saver Enabled

Enforce password history

24 password (s)

Enumerate administrator accounts on elevation Disabled
Enumerate local users on domain-joined computers Disabled
Force shutdown from a remote system Administrators

Generate security audits

Local Service,
Network Service

Hardened UNC P
Hardened UNC P

Hardened UNC Paths

aths:
aths: = \\NETLOGON"

RequireMutualAuthentication = 1
Requirelntegrity = 1

Enabled

Impersonate a cli

ent after authentication

Administrators,
SERVICE, Local
Service, Network
Service

Include command line in process creation events

EFnabled

Increase scheduli

ng priority

Administrators

Interactive logon

: Machine account lockout threshold

10 invalid logon
attempts

Interactive logon

: Machine inactivity limit

900 seconds

is not available)

Interactive logon: Number of previous logons to cache (in case domain controller

10 logon (s)

Interactive logon

: Prompt user to change password before expiration

5 day(s)

807182
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Interactive logon: Require Domain Controller authentication to unlock Disabled
workstation
Interactive logon: Require smart card Disabled

Interactive logon: Smart card removal behavior

No Action

Load and unload device drivers Administrators
Lock pages in memory No One

Manage auditing and security log Administrators Maximum password age 60 days

Microsoft network client: Digitally sign communications (always) Disabled
Microsoft network client: Digitally sign communications (if server agrees) Enabled

Microsoft network client: Send unencrypted password to third-party SMB servers | Disabled

Microsoft network server: Amount of idle time required before suspending
session

15 minute (s)

Microsoft network server: Digitally sign communications (if client agrees) Enabled

Microsoft network server: Server SPN target name validation level Accept if
provided by
client

Minimize the number of simultaneous connections to the Internet or a Windows | Enabled

Domain

Minimum password age 1 day(s)

Minimum password length

7 character (s)

Minimum PIN length Minimum Enabled

PIN length 6

Modify an object label No one

Modify firmware environment values Administrators

MSS: (AutoAdminLogon) Enable Automatic Logon (not recommended) Disabled

MSS: (DisablelPSourceRouting IPv6) IP source routing protection level (protects Enabled

against packet spoofing) Highest

DisablelPSourceRoutinglPv6 protection, source
routing 1is
completely
disabled

MSS: (DisablelPSourceRouting) IP source routing protection level (protects against | Enabled

packet spoofing) Highest

DisablelPSourceRouting protection, source
routing is
completely
disabled
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MSS: (EnablelCMPRedirect) Allow ICMP redirects to override OSPF generated Disabled
routes

MSS: (NoNameReleaseOnDemand) Allow the computer to ignore NetBIOS name | Enabled
release requests except from WINS servers

Network access: Allow anonymous SID/Name translation Disabled
Network access: Do not allow anonymous enumeration of SAM accounts Enabled
Network access: Do not allow anonymous enumeration of SAM accounts and Enabled
shares

Network access: Do not allow storage of passwords and credentials for network | Enabled
authentication

Network access: Let Everyone permissions apply to anonymous users Disabled
Network access: Restrict anonymous access to Named Pipes and Shares Enabled
Network access: Sharing and security model for local accounts Classic - local

users authen-
ticate as

themselves
Network security: Allow Local System to use computer identity for NTLM Enabled
Network security: Allow LocalSystem NULL session fallback Disabled
Network Security: Allow PKU2U authentication requests to this computer touse | Disabled
online identities
Network Security: Configure encryption types allowed for Kerberos RC4\AES128\AES25

6\Future types

Network security: LAN Manager authentication level

Send NTLMv2
response only.
Refuse LM & NTLM

Network security: Do not store LAN Manager hash value on next password Enabled

change

Network security: Force logoff when logon hours expire Disabled

Network security: LDAP client signing requirements Negotiate
signing

Network security: Minimum session security for NTLM SSP based (including
secure RPC) clients

Require NTLMv2
session
security,
Require 128-bit
encryption
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Network security: Minimum session security for NTLM SSP based (including
secure RPC) servers

Require NTLMv2
session

security,
Require 128-bit
encryption

No auto-restart with logged on users for scheduled automatic updates installa- Enabled

tions

Notify antivirus programs when opening attachments Enabled

Password must meet complexity requirements Enabled

Password protect the screen saver Enabled

Perform volume maintenance tasks Administrators

Prevent enabling lock screen camera Enabled

Prevent enabling lock screen slide show Disabled

Prevent the usage of OneDrive for file storage Enabled

Profile single process Administrators

Prohibit connection to non-domain networks when connected to domain authen- | Enabled

ticated network

Recovery console: Allow automatic administrative logon Disabled

Recovery console: Allow floppy copy and access to all drives and all folders Disabled

Replace a process level token Local Service, Network Service Require a Password | Enabled

When a Computer Wakes (On Battery)

Require a Password When a Computer Wakes (Plugged In) Enabled

Require secure RPC communication Enabled

Reset account lockout counter after

60 minute (s)

Restrict Unauthenticated RPC clients Enabled

RPC Runtime Unauthenticated Client Restriction to Apply: Authenticated
Restore files and directories Administrators
Screen saver timeout Enabled

Seconds 900

Set client connection encryption level Enabled

Encryption Level High Level

Set the default behavior for AutoRun Enabled

Default AutoRun Behavior

Do not execute any
autorun commands

Shutdown: Allow system to be shut down without having to log on

EFnabled
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Shutdown: Clear virtual memory pagefile Disabled
Sign-in last interactive user automatically after a system-initiated restart Disabled
Specify the maximum log file size (KB) (Application Log) Enabled
Maximum Log Size (KB) 32768
Specify the maximum log file size (KB) (Security Log) Enabled
Maximum Log Size (KB) 196608
Specify the maximum log file size (KB) (System Log) Enabled
Maximum Log Size (KB) 32768
Store passwords using reversible encryption Disabled
System cryptography: Use FIPS compliant algorithms for encryption, hashing, and | Disabled
signing

System objects: Require case insensitivity for non-Windows subsystems Enabled
System objects: Strengthen default permissions of internal system objects (e.g. Enabled
Symbolic Links)

System settings: Use Certificate Rules on Windows Executables for Software Disabled
Restriction Policies

Take ownership of files or other objects Administrators
Turn off access to the Store Enabled
Turn off app notifications on the lock screen Enabled
Turn off Automatic Download and Install of updates Enabled
Turn off Autoplay Turn off Enabled

Autoplay on All drives
Turn off Data Execution Prevention for Explorer Disabled
Turn off downloading of print drivers over HTTP Disabled
Turn off heap termination on corruption Disabled
Turn off Internet download for Web publishing and online ordering wizards Enabled
Turn off Microsoft consumer experiences Enabled
Turn off Password Manager Disabled
Turn off printing over HTTP Disabled
Turn off the offer to update to the latest version of Windows Enabled
Turn off the SmartScreen Filter Enabled
Turn off toast notifications on the lock screen Enabled
Turn off Windows Update device driver searching Enabled
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Mitigation Options

Turn on convenience PIN sign-in Disabled
Turn on PowerShell Script Block Logging Enabled
Log script block invocation start / stop events: TRUE
Untrusted Font Blocking Enabled

Block untrusted
fonts and log
events

without using the secure desktop

Use a hardware security device Enabled
Use enhanced anti-spoofing when available Enabled
User Account Control: Admin Approval Mode for the Built-in Administrator Enabled
account

User Account Control: Allow UlAccess applications to prompt for elevation Disabled

User Account Control: Behavior of the elevation prompt for administrators in
Admin Approval Mode

Prompt for
consent on the
secure desktop

User Account Control: Behavior of the elevation prompt for standard users

Prompt for

credentials

User Account Control: Detect application installations and prompt for elevation Enabled

User Account Control: Only elevate executables that are signed and validated Disabled
User Account Control: Only elevate UlAccess applications that are installed in Enabled
secure locations

User Account Control: Run all administrators in Admin Approval Mode Enabled

User Account Control: Switch to the secure desktop when prompting for Enabled
elevation

User Account Control: Virtualize file and registry write failures to per-user Enabled
locations

WDigest Authentication (disabling may require KB2871997) Disabled
Windows Firewall: Domain: Display a notification No

Windows Firewall: Domain: Inbound connections Enabled
Inbound Connections Block
Windows Firewall: Domain: Logging: Log dropped packets Yes

Windows Firewall: Domain: Logging: Log successful connections Yes
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Windows Firewall: Domain: Logging: Name $SYSTEMROOTS
\System32\
logfiles
\firewall\doma
infw.log

Windows Firewall: Domain: Logging: Size limit (KB) 16384 KB

Windows Firewall: Domain: Outbound connections Allow

Windows Firewall: Private: Display a notification No

Windows Firewall: Private: Inbound connections Enabled

Inbound Connections Block

Windows Firewall: Private: Logging: Log dropped packets Yes

Windows Firewall: Private: Logging: Log successful connections Yes

Windows Firewall: Private: Logging: Name %$SYSTEMROOTS%
\System32\
logfiles
\firewall\priv
atefw.log

Windows Firewall: Private: Logging: Size limit (KB) 16384 KB

Windows Firewall: Private: Outbound connections Allow

Windows Firewall: Public: Apply local connection security rules No

Windows Firewall: Public: Apply local firewall rules No

Windows Firewall: Public: Display a notification No

Windows Firewall: Public: Inbound connections Enabled

Inbound Connections Block

Windows Firewall: Public: Logging: Log dropped packets Yes

Windows Firewall: Public: Logging: Log successful connections Yes

Windows Firewall: Public: Logging: Name $SYSTEMROOT%
\System32\
logfiles
\firewall\publ
icfw.log

Windows Firewall: Public: Logging: Size limit (KB) 16384 KB

Windows Firewall: Public: Outbound connections Allow

Table 10: Table Title
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6
6.1
/A CAUTION!
6.2
Action
6.2.1
Action
6.2.2

6.1 Safety During Operation

Operation

Safety During Operation

Improper operator training

could lead to poor scan quality, damage to system components, or
inadvertent patient safety compromise.

» Train all operators fully.

» Ensure all personnel are familiar with the information contained
in Safety and Certifications [ 9].

» Ensure that routine maintenance has been properly carried out
in conformance with the Maintenance Schedules described in
the chapter Maintenance [ 143].

For lens cleaning instructions, refer to: Cleaning the Front Lens
[* 137].

Preparing the Device

To prepare the device:

1. Wipe the chin rest and forehead rest with an alcohol pad, and
allow the assembly to dry. (See Cleaning the Chinrest and
Forehead Support [ 141].)

2. Carefully read and understand any instructions provided by the
officiating physician or researcher.

Finding a Patient

To find a patient:

1. In the Search bar, type the first name, last name, patient ID, or
a scan date of the person you want to find.

2. Click the Search icon.
3. To refine your search criteria, use Advanced Search.

Selecting the Patient

Finding a patient's name can vary depending on the systems you
use.

m |f you use an EMR system:
— The patient's name might be listed under Today

— If the patient is not listed under Today, search for their
name or ID (See Finding a Patient [ 87]).
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— If the patient is not in the database, add the patient's infor-
mation. (See Adding a Patient [ 46]).

m |f you do not use an EMR system:

— Search for the patient's name or ID Search (See Finding a
Patient [ 87]).

— If the patient is not in the database, add the patient's infor-
mation. (See Adding a Patient [ 46]).
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To select a patient:
Action 1. Find the patient's name using the list or search and select the

patient's name.

2. Click Acquire.
6.3 Preparing the Patient

NOTE Keep the front of the lens clean.
The quality of image capture is affected by the cleanliness of the

front lens.

» Avoid touching the lens with anything but approved cleaning
equipment.

» Use the protective cover to keep dust off the lens when the
device is not in use.

For complete instructions on cleaning the lens, refer to: Cleaning
and Disinfection [ 137]

6.3.1 Dilating the Patient’s Eyes (Optional)

The minimum pupil size for the CLARUS 500 is 2.5 mm, which is
typically achieved without dilation.
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6.3.2 Lifting the Patient's Eyelid (Optional)

Because the patient's eye is very close to the acquisition head, you
might need to re-position the computer screen or reach around the
instrument to lift a patient's eyelid.

The option you use can also depend on whether you are scanning
the patient's right or left eye.

6.3.2.1 Option 1: Reach Between

This method works better if the operator cannot comfortably reach
around the acquisition head. However, with the computer screen
moved to provide access, the operator has a more limited view of
the screen.

To lift the eyelid by reaching between:
Action 1. Swing the computer aside to allow access the patient's eye.

1

N

AL
A T

2. Reach between the acquisition head and the computer to
access the back of the patient support.

3. Rest your hand against the back of the forehead rest and lift
the patient's eyelid.

6.3.2.2 Option 2: Reach Around

This method provides the operator a consistent view of the
computer screen. However, some operators may not be able to
comfortably reach the patient's eyelid.

To left the eyelid by reaching around:

Action 1. Reach around the acquisition head to access the back of the
patient support.
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2. Rest your hand against the back of the forehead rest and lift
the patient's eyelid.

6.3.3 Positioning the Patient

Pinch hazard for hands and fingers.

A CAUTION!

» Keep operator and patient hands and fingers away from
crosstable during alignment and image capture.

To position the patient:

Action 1. Adjust the table (and patient chair, if needed) until the patient
can comfortably reach the headrest and chin rest.

2. To move the table up, press and hold the up arrow (1).
3. To move the table down, press and hold the down arrow (2).
4. Ask the patient to:

= Sit comfortably with feet flat on the ground.
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= Lean forward slightly, grasping the table handles if needed
for stability.

= Rest their chin in the chin rest.
= Rest their forehead against the forehead rest.
' i

5. Adjust the chin rest up or down as needed until align the
patient's canthus to the canthus marker on the patient support.

/
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6. Swing the acquisition head left to align with the patient's right
eye or right to align with the patient's left eye.

a[ -

W
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6.3.4 Aligning and Focusing on the Patient's Eye

In addition to the preview image, two images of the iris help to
align the eye.

Smith, John

Figure 11: Acquire Screen

The top iris image is used for vertical alignment. The height of the
band is the minimum pupil size required. If the pupil is smaller than
the transparent band, you can change the pupil setting to Non-
Myd, or dilate the patient's pupils.

To align and focus on the patient's eye:
Action 1. Push the acquisition head closer to the patient.

2. Twist the joystick to move the acquisition head up or down
until the patient's pupil is aligned with the band.

w
L

3. If the patient's pupil is smaller than the transparent band,
change the setting to Non-Myd or dilate the patient's pupil
(Dilating the Patient’s Eyes (Optional) [ 88]).

4. Slide the instrument front to back and side-to-side until the
patient's pupil is centered on the yellow cross hairs on the
bottom iris image.
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= When the pupil is aligned, a live view of the fundus appears
in the live IR preview window.

5. Ensure that the image is in focus. If needed, manually focus the
image (Manually Focusing the Image [ 110]).

6. Make fine adjustments as needed to eliminate any shadows
showing in the IR preview window.

7. If either alignment is not centered, repeat these steps until they
are centered.
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If the acquisition head drifts after you align it, you can set
NOTE o
the lock to secure it in place.
g
(uARLs
i

&
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6.4 Acquire Images

6.4.1 About Acquisition Options

6.4.1.1 Field of View Options

1 Widefield (WF)
Single image, 133° wide by 133° high
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2 Ultra-widefield (UWF)

Two image montage, 200° wide by 133°
high

3 Auto Montage

Four image montage, 200° wide by 200°
high

4 Montage

Up to six images montaged in an
operator-selected configuration

6.4.1.2 Scan Types

NOTE Example images shown below are taken from scans acquired
from multiple subjects.
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Figure 12: Scan Types

1 Color Color

High resolution, color
images of the fundus
appear similar in color
to direct observation
(ophthalmoscopy).

You can also view a
monochrome image of
each composite color
(red, green, and blue).

Blue Channel

Blue channel images
increase visibility of the
anterior retinal layers.

Red Channel

Red channel images
reveal the choroid in
more detail.
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Green Channel

Green channel images
provide excellent
contrast of the retina,
especially of vascu-
lature and hemor-
rhages.

Infrared reflectance

Infrared light is used to
capture these images,
with the unique
property of increased
penetration through
tissue, providing
improved visualization
of choroidal structures.
A monochrome image
is generated.

FAF-Green

Fundus autofluores-
cence with green
excitation. The eye is
illuminated with light
at a wavelength that
stimulates the natural
fluorescence of
lipofuscin. A
monochrome image is
generated.

FAF-Blue

Fundus autofluores-
cence with blue
excitation. The eye is
illuminated with light
at a wavelength that
stimulates the natural
fluorescence of
lipofuscin. A
monochrome image is
generated.

F+3

+++

A+

Figure 13: Fixed Targets

6.4.1.3 Internal Fixation Targets

m Central
m Temporal
m Nasal

The internal fixation target set positions include 9 fixed points to
steer a patient's gaze:

2660021165005 Rev. B 2017-10
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m Superior

Inferior

Superotemporal

Superonasal

Inferonasal

m Inferotemporal

You can override the preset fixation targets and choose any
location within the patient's field of view (See Manually Positioning
the Internal Fixation Target [ 111].)

If the patient is unable to see the fixation target, you can blink the
fixation target to help the patient to see it. (See Blinking the
Fixation Target [ 109].)

Internal fixation targets adjust to any point within the 90 degree
circular FOV.

6.4.1.3.1 Internal Fixation Target Preset Positions
Widefield (WF) r1 Central
==
h 4
Ultra widefield V- "\ | Temporal
+ +
A 4 Nasal
AutoMontage V +\ | Temporal
i"'] Superior
Nasal
Inferior

Table 11: Preset Internal Fixation Targets for Scans

Tips

6.4.1.3.2 Tips to Help Patients Find Fixation Targets

Some patients have difficutly seeing the internal fixation target.
When the target is on the side (nasal / temporal), it can appear as
though the internal fixation target is outside the acquisition head.

When a patient cannot see the fixation target, you can help them
locate it using the tips below.

1. Describe the target (a green star pattern).

2. Pull acquisition head towards you and realign the instrument
(Aligning and Focusing on the Patient's Eye [ 93]).

100/ 182
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3. Blink the fixation target (1) (Blinking the Fixation Target
[+ 109)).

Smith, John

1

4. For temporal fixation targets, swivel the acquisition head
slightly towards the center.

5. Increase the duration of fixation target blinks (Configuring
Acquisition Settings [ 69]).

6. Have the patient follow the fixation target from the center
position to the side:

— Manually position the fixation target (1) towards the
center (Manually Positioning the Internal Fixation Target

[ 111]).

— When the patient sees the centered target, ask them to
follow the target as you manually reposition it to the side.

Smith, John

1

7. If the patient still cannot see the internal fixation target, use the
external fixation target (Using the External Fixation Target
[" 112]).
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6.4.2 Capturing a Widefield Image

rF.
h 4
Figure 14: Widefield Fixation
Target

Figure 15: WF Image Example

When you capture a widefield (WF) image, CLARUS 500 takes one
image and with a fixation target preset near the center.

If the patient cannot see the fixation target, you can:
m Blink the fixation target: Blinking the Fixation Target [ 109]

m Change the fixation target: Manually Positioning the Internal
Fixation Target [ 111]

m Use the external fixation target: Using the External Fixation
Target [ 112]

To capture a WF image:
Prerequisite M The device is prepared. (See Preparing the Device [ 87].)
M The patient is prepared. (See Preparing the Patient [ 88].)
Action 1. Under Scans, select WF.

2. Select the Scan Type (Color, IR, FAF-Green, or FAF-Blue). For
more information , refer to: Scan Types [ 97].

3. Under Settings, select Myd if the patient's pupil is dilated and
Non Myd if the patient's pupil is not dilated.

4. Instruct the patient to look inside the lens, focus on the green
fixation target and blink naturally.

NOTE If the patient cannot see the fixation target, refer to: Tips to
Help Patients Find Fixation Targets [ 100].

5. The instrument automatically focuses the image. To manually
adjust focus, refer to: Manually Focusing the Image [ 110].

6. Instruct the patient to blink and then open their eyes wide.
7. Click the joystick button or click Capture.

= A preview of the captured image appears for several
seconds and is added to the selection bin.

8. Repeat adjustments and scans as needed until all scans are
acquired.
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6.4.3 Capturing an Ultra-widefield Image (2-lmage Montage)

2

Figure 16: UWF Fixation Targets

Figure 17: UWF Image Example

When you capture an ultra-widefield (UWF) image, CLARUS 500
takes two widefield images and stiches them together for a wider
view of the retina. The fixation targets for these images are preset
at temporal and nasal.

To capture an UWF image:

Prerequisite M The device is prepared. (See Preparing the Device [ 87].)

M The patient is prepared. (See Preparing the Patient [ 88].)

Action 1.
2.

Under Scans, select UWF.

Select the Scan Type (Color, IR, FAF-Green, or FAF-Blue). For
more information about Scan Types, refer to: Scan Types

[+ 97].

For Pupil Size, select Myd if the patient's pupil is dilated and
Non-Myd if the patient's pupil is not dilated.

. Instruct the patient to look inside the imaging aperture, focus

on the green fixation target and blink naturally.

NOTE If the patient cannot see the fixation target, refer to: Tips to
Help Patients Find Fixation Targets [ 100].

5.

The instrument automatically focuses the image. To manually
adjust focus, refer to: Manually Focusing the Image [ 110].

6. Instruct the patient to blink and then open their eyes wide.

7. Click the joystick button or click Capture.

= A preview of the captured image appears for several
seconds and is added to the selection bin.

= The internal fixation target advances to the next position in
the sequence.

Recheck adjustments and focus for the second scan in the
series, and click Capture.

= A preview of the captured image appears for several
seconds and is added to the capture bin.

= If the images montage successfully, each thumbnail displays
a green checkmark.

= If an image did not montage successfully, the thumbnail
displays a yellow exclamation point.

. To delete and retake the image, refer to: Deleting or Replacing

an Image [ 113].
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6.4.4 Capturing an AutoMontage Image (4-lmage Montage)

Figure 18: AutoMontage Example

When you capture an AutoMontage image, CLARUS 500 takes four
widefield images and stitches them together for a wider view of
the retina. The fixation targets for these images are preset at

F+Y
A+ d

If you do not complete all four scans, CLARUS 500 saves the
completed scans as individual wide field scans.

To capture an AutoMontage image:
Prerequisite M The device is prepared. (See Preparing the Device [ 87].)
M The patient is prepared. (See Preparing the Patient [ 88].)
Action 1. Under Scans, select AutoMontage.

2. Select the Scan Type (Color, IR, FAF-Green, or FAF-Blue). For
more information about Scan Types, refer to: Scan Types
[ 97].

3. For Pupil Size, select Myd if the patient's pupil is dilated and
Non-Myd if the patient's pupil is not dilated.

4. Instruct the patient to look inside the imaging aperture, focus
on the green fixation target and blink naturally.

NOTE If the patient cannot see the fixation target, refer to: Tips to
Help Patients Find Fixation Targets [ 100].

5. The instrument automatically focuses the image. To manually
adjust focus, refer to: Manually Focusing the Image [ 110].

6. Instruct the patient to blink and then open their eyes wide.
7. Click the joystick button or click Capture.

= A preview of the captured image appears for several
seconds and is added to the selection bin.

8. Ask the patient to relax while the you review the scan.

= The internal fixation target advances to the next position in
the sequence.

9. Next Scan: confirm alignment and focus for the next scan in
the series, and click Capture.

= A preview of the captured image appears for several
seconds and is added to the capture bin.
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= The internal fixation target advances to the next position in
the sequence.

10. Repeat Next scan steps until all four scans are complete.

= If the images montage successfully, each thumbnail displays
a green checkmark.

= If an image did not montage successfully, the thumbnail
displays a yellow exclamation point.

11.To delete and retake the image, refer to: Deleting or Replacing
an Image [ 113].

6.4.5 Capturing a Montage Image (2-6 Image Custom
Montage)

Prerequisite

Action

Figure 19: Custom Montage Example

When you capture a custom Montage image, CLARUS 500 takes a
series of widefield images and stitches them together. You can
decided how many images to include in the montage. For each
image, you can choose any internal fixation target location or have
the patient focus on the external fixation target (Using the External
Fixation Target [ 112]).

To capture a Montage image:
M The device is prepared. (See Preparing the Device [ 87].)
M The patient is prepared. (See Preparing the Patient [ 88].)
1. Under Scans, select UWF.

2. Select the Scan Type (Color, IR, FAF-Green, or FAF-Blue). For
more information about Scan Types, refer to: Scan Types
[ 97].

3. Under Settings, select Myd if the patient's pupil is dilated and
Non Myd if the patient's pupil is not dilated.

4. Using the touchscreen or mouse, select a fixation target (1) in
the Preview panel.
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Smith, Jahn

5. Instruct the patient to look inside the imaging aperture, focus
on the green fixation target and blink naturally.

NOTE If the patient cannot see the fixation target, refer to: Tips to
Help Patients Find Fixation Targets [ 100].
6. The instrument automatically focuses the image. To manually
adjust focus, refer to: Manually Focusing the Image [ 110].

7. Instruct the patient to blink and then open their eyes wide.
8. Click the joystick button or click Capture.

= A preview of the captured image appears for several
seconds and is added to the selection bin.

9. Next Scan: confirm alignment and focus for the next scan in
the series, and click Capture.

= A preview of the captured image appears for several
seconds and is added to the selection bin.

10. Repeat Next scan steps for each scan in the series (2-6 total).
11. When you are finished taking scans, click End Montage.

= If the images montage successfully, each thumbnail displays
a green checkmark.

= If an image did not montage successfully, the thumbnail
displays a yellow exclamation point.

12.To delete and retake the image, refer to: Deleting or Replacing
an Image [ 113].

6.4.6 Capturing a Stereo Image

A stereo image is comprised of two separate images of the same
eye, offset to produce a stereoscopic pair.
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A pair of images of the same eye created as a stereo pair are stored
the pair using Stereometric Relationship 10D in DICOM. In the
Review screen, stereoscopic pairs display as linked viewports for
simultaneous pan and zoom.

To capture a stereo image:
Prerequisite M The device is prepared. (See Preparing the Device [ 87].)
M The patient is prepared. (See Preparing the Patient [ 88].)
Action 1. Under Scans, check Stereo.

2. Select the Scan Type (Color, IR, FAF-Green, or FAF-Blue). For
more information about Scan Types, refer to: Scan Types
[+ 97].

3. Under Settings, select Myd if the patient's pupil is dilated and
Non Myd if the patient's pupil is not dilated.

4. Adjust the alignment for the first stereo image (1) (offset to one
side of the pupil).

5. Instruct the patient to look inside the imaging aperture, focus
on the green fixation target and blink naturally.

NOTE If the patient cannot see the fixation target, refer to: Tips to
Help Patients Find Fixation Targets [ 100].

6. The instrument automatically focuses the image. To manually
adjust focus, refer to: Manually Focusing the Image [ 110].

7. Instruct the patient to blink and then open their eyes wide.
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8. Click the joystick button or click Capture.

= A preview of the captured image appears for several
seconds and is added to the selection bin.

9. Adjust the alignment for the second stereo image (2) (offset to
the other side of the pupil).

= A preview of the captured image appears for several
seconds and is added to the selection bin.

10. Ask the patient to relax while the you review the scan.

6.4.7 Capturing an External Eye Image

Capturing external eye images allows you to store a photograph of
the eye along with the retinal images. Each external image is stored
as an individual scan.

To capture an external eye image:
Prerequisite M The device is prepared. (See Preparing the Device [ 87].)
M The patient is prepared. (See Preparing the Patient [ 88].)
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Action 1. Under Scans, check External.

2. Straighten the acquisition head until the eye is directly in front
of it.

3. Move the instrument all the way back.

4. Slowly move the instrument forward until the patient's eye
appears in the Preview screen as you want it to appear in the
image.

5. Use the joystick to manually focus the image.

6. Instruct the patient to look straight ahead. The fixation target
may not be visible and it is not necessary for the patient to
focus on the fixation target for this scan.

7. Instruct the patient to blink.
8. Click the joystick button or click Capture.

9. Repeat adjustments and scans as needed until all scans are
acquired.

6.4.8 Blinking the Fixation Target

If the patient is having trouble seeing the internal fixation target,
you can blink the target to make it easier for them to see. To can
change the blink settings, refer to: Configure Capture Settings.

To blink the fixation target:

Prerequisite M A patient is being prepared for Scan Acquisition and cannot
see the fixation target.
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Smith, John

Action 1. Click the blink buttion (1).
Result v" The internal fixation target blinks several times.

6.4.9 Manually Focusing the Image

To focus the image manually:
Prerequisite M You reached the focus step in a Scan Acquisition task.
M You want to manually focus the image.
Action 1. Uncheck Auto.

2. Turn the focus knob on the acquisition head (1) or use (+ and
-) (2) or the focus slider (3) on the screen to manually adjust
focus.

1107182 2660021165005 Rev. B 2017-10



Instructions for Use 6 Operation
2660021165005_Rev_B 6.4 Acquire Images

Smith. John

3. Use the focusing guides (4) in the upper left corner of the IR
Preview panel, to aid in focus.

6.4.10 Manually Positioning the Internal Fixation Target

You can place the internal fixation target anywhere on the screen
using the touchscreen or the mouse.

To manually position the internal fixation target:

Prerequisite M A patient is being prepared for Scan Acquisition and you
want to change or set the internal fixation target.

Smith, John

1

Action 1. In the IR Preview panel, double-click (or press the touchscreen
and hold) to select a position for the internal fixation target (1).

Result v' The internal fixation target moves to your selected location
in both the Preview panel and the patient's FOV.

2660021165005 Rev. B 2017-10 1117182



Instructions for Use
2660021165005_Rev_B

6 Operation
6.4 Acquire Images

6.4.11 Using the External Fixation Target

The external fixation target is a light you can position to guide the
patient's gaze. The external fixation target is in the accessory kit.
Use this target when the patient cannot see the internal fixation

target.

To install the external fixation target:
Action 1. Remove the external fixation target from the accessory kit.

2. Install the external fixation target (1) onto mount (2) on the
patient support (3).

3. Position the target where you want the patient to focus.

6.4.12 Checking Scan Quality

Once data acquisition is complete, scans must be reviewed for
acceptance prior to being released for analysis.

Review all scans carefully. If possible, retake scans that do not pass
the acceptance criteria (Deleting or Replacing an Image [ 113]).
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To check scan quality:
Action 1. Check that the focus is sharp and clear.
2. Ensure that the image is illuminated uniformly.

3. Ensure that there are few to no artifacts that cast shadows on
the image.

Result v" If image quality is degraded, contact ZEISS customer service
(https://www.zeiss.com/).

6.4.13 Deleting or Replacing an Image

To delete or replace an image:
Prerequisite M You reached the image check step in a Scan Acquisition task.
M You want to delete or replace an image.
Action 1. In the selection bin, locate the image you want to recapture.

s

Serath dohn

1

2. Click on the X (1) to delete the image.

= A confirmation opens.
3. To delete and recapture the image, click Delete & Recapture.
4. To delete the image, click Delete.

6.5 Analyze Images
There are two Analyze modes: Proof and Review.
Proof allows you to sort and select images.

Review allows you to view, compare, and annotate images. .
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6.5.1

6.5.2

6.5.3

Action
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Proof

Proof shows an overview of all images for the patient. Using the
Proof Sheet, you can filter images by scan type, date of acquisition,
laterality and favorite status.

Edwards. Jeff

Figure 20: Analyze > Proof Screen

Review

Review shows the images selected in Proof. Review allows you
annotate and edite scans, save them and print a report.

o 2oea =n

Mliian. Hamdsrian

Figure 21: Analyze > Review Screen

Opening the Analyze Window
You can analyze that patient's images by clicking Analyze.

To open the Analyze window:
1. Select the patient (Selecting the Patient [ 87]).
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2. Click Analyze.

6.5.4 Sorting and Selecting Images

Proof allows you to find and select images you want to include in
Review.

To find the images to include in the Review, you can sort and filter
in the following ways:

m Laterality
m Scan type
m Date and time acquired

To sort and select images:
Prerequisite M The selected patient has saved scans
M The Review screen is open.

12 11 10 9

Action 1. In the View panel (11), click on the image(s) you want to
include in review. Use the sorting and filtering options to help
locate the images.

2660021165005 Rev. B 2017-10 1157182



6 Operation

Instructions for Use

6.5 Analyze Images

Prerequisite
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6.5.5

6.5.5.1
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= Thumbnails of the selected image(s) appear in the selection
bin (10).

2. To mark an image as a favorite, click on the image's star in the
view panel.

= The star turns yellow.
3. To view only images marked as favorites, click Favorites (2).

Ca

To view scans acquired within a certain date range, choose a
From and To date (4).

To filter scans by laterality, click on OD, OU or OS (3).
To filter scans by scan type, click on a scan type (5).
To sort selected scans by date, choose Sort > Date/ Time (7).

© N o w

To sort selected scans by laterality, choose Sort > Laterality
(7).
9. To sort selected scans by scan type, choose Sort > Scan Type

(7).

10. Once all scans for review are in the selection bin (10), click
Review (9).

Editing Scanned Images

To edit images, select one or more images in the viewport and use
the editing toolbar.

To apply the same edits to multiple images, select multiple images
before you begin to edit.

Choosing How Many Images to View

You can scroll through the selected images one at a time. You can
also scroll through selected images with multiple images in the
viewport (2, 3, 4, 8, 9, or 16 at a time).

Use the viewport numbers to decide how many of the images from
the selection bin to include in the view panel.]

To choose how many images to view:

M Multiple images are selected (Sorting and Selecting Images
[ 115]).

M The Analyze > Review window is open (Opening the Analyze
Window [ 114]).

1. To view 1 image at a time in the view panel, click viewport 1.
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Exclmarchi fodl

[ Pt gy |
2. To view 2 images at a time in the view panel, click viewport 2.

A9 k2

[ Pt gy |
3. To view 3 images at a time in the view panel, click viewport 3.

Eclmarchi Fodl

BA9 k2

[ reren el |

4. To view 4 images at a time in the view panel, click viewport 4.
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[ Pt gy |
5. To view 8 images at a time in the view panel, click viewport 8.

=] =
6. To view 9 images at a time in the view panel, click viewport 9.

A9 k2

[ Pt gy |
7. To view 16 images at a time in the view panel, click viewport
16.
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LR

To scroll throught the next set of images, click the scroll icon

( ).

6.5.5.2 Viewing Separate Color Channels of a Full Color Image

When analyzing a true color image, you can also view each color
channel individually. You can select:

m Color
m Red
m Green
m Blue

Prerequisite M True color image(s) exist in the patient record (Scan Types
[+ 97])

M True color image(s) are selected for review (Sorting and
Selecting Images [+ 115])

M The Analyze > Review window is open (Opening the Analyze
Window [~ 114]).

Action 1. Click on a true color thumbnail image in the selection bin.

= A larger view of the image appears in the preview.

[ Pt [ il
2. To view the red channel image, click Color > Red.
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= The red channel image opens.

= =]
3. To view the green channel image, click Color > Green.

= The green channel image opens.

4. To view the blue channel image, click Color > Blue.

= The blue channel image opens.
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6.5.5.3 Zooming In or Out

To zoom in or out:

Prerequisite M The Analyze window is open (Opening the Analyze Window
[ 114]).

1. Select the image you want to adjust.

Action = The selected image is outlined in blue.

2. Click the zoom adjustment icon.

= The zoom adjustment panel opens.

L Aditn as

3. Zoom and pan the image until you see the area of the image
you want to save.

4. Close the zoom adjustment panel.

6.5.5.4 Annotating Images

Most annotations must be inside the image or field of view to save
them on an image. The caliper tool for indicating measurement can
stretch beyond the image borders.

@ Hide Al
Figure 22:
Text Adds text annotations to the
image
m Arrow Draws an arrow on the image
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Prerequisite

Action

Prerequisite

Action

6.5.5.4.1

6.5.5.4.2
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Caliper Draws a line and adds the
measurement (in mm or pm) to
the image

&= Freehand Draws a freehand shape and adds

the area enclosed by the shape (in
mm?) to the image

Circle Adds a circle and its area (in mm?)
or diameter (in mm) to the image

B Select Selects an annotation so that it
can be moved, edited, or deleted

m Copy Copies annotations from one
image onto another image

Delete Removes the selected

annotation(s)

Hide All Hides all annotations

Selecting the Annotation Tool

You can draw any length arrow or multiple arrows on the image to
identify something specific on the image. You can add text to
arrows to label what you are identifying on the image. After you
place arrows on the image, you can resize, move or delete them.

To select the Annotation tool:

M The Analyze window is open (Opening the Analyze Window
[* 114]).

1. Select the Annotations tool.
= The annotations tools panel opens.

Adding Text to Images

You can add text labels to an image to identify findings. After you
place text labels on an image, you can edit, move, or delete them.

To add text to images:

M The Analyze window is open (Opening the Analyze Window
[ 114]).

M The Annotation tool is selected (Selecting the Annotation Tool
[ 122]).

1. Select the Text tool.
2. Touch or click on the starting point for the text.
= The text insert tool opens.
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Result

6.5 Analyze Images

LM

LARLIS 500

B tiide a0

Show Arrow
Changed @
QK Cancel

3. Type your text annotation.

4. If you want an arrow to appear with the text, click Show
Arrow.

5. Click OK.
6. Close the annotations panel.

v" The text annotation appears on the image.

6.5.5.4.3 Adding Arrows to Images

Prerequisite

Action

You can draw any length arrow or multiple arrows on the image to
identify something specific on the image. You can add text to
arrows to label what you are identifying on the image. After you
place arrows on the image, you can resize, move or delete them.

To add arrows to images:

M The Analyze window is open (Opening the Analyze Window
[ 114]).

M The Annotation tool is selected (Selecting the Annotation Tool
[ 122)).

1. Select the Arrow tool.

2. Point to the location in the image where you want to begin to
draw the line with an arrow.
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3. Touch or click on the appropriate starting point and drag to the
area you want the arrow to point.

4. Close the annotations panel.
Result v' The arrow appears on the image.

6.5.5.4.4 Adding Measurements to Images

When you draw caliper lines on an image, the review software
calculates the measurement. After you draw caliper lines, you can
edit, move or delete them.

To add measurements to images:

Prerequisite M The Analyze window is open (Opening the Analyze Window
[ 114]).

M The Annotation tool is selected (Selecting the Annotation Tool
[ 122]).

1. Select the Caliper tool.

2. Touch or click on the appropriate starting point on the image
and drag to the appropriate end point.
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3. Close the annotations panel.
Result v" When you finish drawing the caliper line, the review
software calculates its length.

6.5.5.4.5 Circling an Area of an Image

To circle an area of an image:

Prerequisite M The Analyze window is open (Opening the Analyze Window
[ 114]).

M The Annotation tool is selected (Selecting the Annotation Tool
[ 122]).

1. Select the Circle tool.

2. Touch or click on the appropriate starting point and drag
around the area of the image you want to emphasize.

Action
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3. Close the annotations panel.
Result v When you finish drawing the circle, the review software
calculates the area.
6.5.5.4.6 Drawing a Freehand Shape in an Image

The Freehand tool allows you to draw any shapes around findings
you want to emphasize. After you place shapes on the image, you
can move or delete them.

To draw a freehand shape:

Prerequisite M The Analyze window is open (Opening the Analyze Window
[ 114]).
M The Annotation tool is selected (Selecting the Annotation Tool
[ 122]).
<7 1. Select the Freehand tool.
Action 2. Touch or click on the appropriate starting point on the image

and draw around the area of interest.

126/ 182 2660021165005 Rev. B 2017-10



Instructions for Use 6 Operation
2660021165005_Rev_B 6.5 Analyze Images

Color w

8/8/2017 | I I/
os :

% Delete @ Hide Al

Area:51.41 mm?

= When you connect to the starting point, the review
software calculates the area of your shape.

3. Close the annotations panel.
6.5.5.4.7 Copying and Pasting Annotations
NOTE Copy Annotation registers the images to each other in order
to copy to the appropriate location. This process will only
work well for good quality images where the images are of
the same eye over the same portion of the eye.

If the registration between images is poor, the annotations may be
copied to the wrong part of the image.

» You can select the annotation and move it to the correct
location.

To copy and paste annotations:

Prerequisite M The Analyze window is open (Opening the Analyze Window
[ 114]).
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M The Annotation tool is selected (Selecting the Annotation Tool
[ 122]).

1. Click on the copy icon.

= The copy & paste annotations panel opens showing thumb-
nails of the selected images. The thumbnails in the panel
are in the same configuration as the larger images in
Preview.

2. Inside the copy & paste panel, click on the source icon and
drag it to the thumbnail that represents the image with annota-
tions to copy.

Delete @ Hide Al

Drag onto source image. Drag onto destination image.

3. Inside the copy & paste panel, click on the destination icon and
drag it to the thumbnail that represents the image to paste
annotations onto.
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Drag onto source image. Drag onto destination image.

Cancel

4. Click Copy.
= The annotations appear on both images.
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5. Close the annotations panel.

6.5.5.4.8 Hiding Annotations in an Image

Hide All temporarily hides all annotations on the image allowing
you to see the original image only.

To hide annotations:

Prerequisite M The Analyze window is open (Opening the Analyze Window
[ 114]).
M The Annotation tool is selected (Selecting the Annotation Tool
[ 122]).
1. Select the image you want to view without annotations.
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Action = The selected image is outlined in blue.

[ et [ —e=pen
2. Check Hide All.

= Annotations are temporarily hidden from view.

[ reren el |

3. To view the annotations again, uncheck Hide All.

4. Close the annotations panel.

6.5.5.4.9 Deleting Annotations

You can select any annotation from the image or select multiple
annotations and delete them together.

To delete an annotations:

Prerequisite M The Analyze window is open (Opening the Analyze Window
[" 114]).
M The Annotation tool is selected (Selecting the Annotation Tool
[ 122]).
Action 1. Click on the selection tool.

2. Select annotations to delete.
3. Click Delete.
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6.5.5.5 Adjusting Image Brightness

To adjust image brightness:

Prerequisite M The Analyze window is open (Opening the Analyze Window
[ 114]).

M Image(s) are selected (Sorting and Selecting Images [+ 115])

1. Select the image you want to adjust.
Action = The selected image is outlined in blue.
2. Click the brightness adjustment icon.

= The brightness adjustment panel opens.

3. Adjust the settings until the image enhanced as you want to
save it.

4. Close the brightness adjustment panel.

6.5.5.6 Rotating Images
Each time you click the rotate image icon, the image rotates 180°.

To rotate an image:
Prerequisite M The annotation tool is open.
Action 1. Click on the selection tool.
2. Select the image you want to rotate.
3. Click on the rotate icon.
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6.5.6 Manually Creating a Montage

You can select from two to six images of the same eye to create a
montage image.

To create a montage manually:
Prerequisite M The Analyze > Review screen is open.

M Two to six images of the same eye are selected (Sorting and
Selecting Images [+ 115]).

Action 1. Click Montage.
= The montage bin opens.

Echurarchi_ ol

2. Drag each thumbnail image want to include in the montage
into a slot in the Montage bin.

3. Click Create.
= A progress bar appears as the montage image forms.
4. When the montage image completes, click Save.
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Action
Result

B

Prerequisite

Action

6.5 Analyze Images

6.5.7 Viewing Stereo Images

Stereo image pairs can be viewed in stereo mode. When you view
image pairs in stereo mode, viewports are linked, so that pan and
zoom apply to both images.

When Stereo Mode is selected, all non-stereo images are filtered
out of the selection bin and only 2-up and 4-up viewing options are
available for viewing the selected Stereo pairs.

To view stereo images:
M The Review screen is open.
1. Click the Stereo icon.

v Only stereo image pairs appear in the selection bin.

6.5.8 Saving Edited Images

You can save the original image with the edits and annotations you
made or you can save a copy of the edited image. The thumbnail
identifies images that were edited.

If you did not make any changes to an image you select to save, no
changes or copies of the image are made.

To save an edited image:

M Analyze - Review window is open.
M Editing and annotations were made (as required) on image(s).
1. Click the Save icon.

Eclmarchi Fodl

e Py |

= Images that you edited or annotated are automatically
selected and identified to Save.

2. To deselect an image, click on its thumbnail.
= Save changes to Discard Edits.

3. To save the original image(s) with your editing and annotations,
click Save.
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4. To save a copy of the image with the editing and annotations,
click Save as Copy.

= The new copy appears in the selection bin.

6.5.9 Creating a Report

For information about configuring reports, refer to: Configure
Reports

To create a report:

M The review screen is open.
1. Click the Reports icon.

= A report preview opens.

et hl—
5 4
Select the type of document for the report (1).
Select landscape or portrait orientation (2).
If you want to change the image size, zoom in or zoom out (3).

vk WeN

To add a comment to the report:
Click Comment (5).
Type your comments and click Add Comment.

6. Select Print, Save, or Save & Print (4).

6.6 Shutdown

The windows password must be updated every 60 days.

Shut down and restart the instrument regularly. On startup, the
instrument prompts you when it is time to update the windows
password.

1347182
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6.6.1

Action

6.6.2

A CAUTION!

Action

6.6 Shutdown

Logging Off

To log off:

1. Select the X in the upper right corner.

2. Select Log off.

Shutting Down

Do not use the power switch to shut down the system
or you could interrupt automatic archiving or interrupt operating
system updates.

Each time you shut down the system, all shutdown activity
completes (if set) and CLARUS 500 retains a log of the actions
completed. Activities that can be set to run each time the system
shuts down include:

m Export images and patient data to DICOM (Configuring Export
Settings [ 56])

m Automatic backups (Configuring Automatic Backups [ 62])

Do not switch off the power until the CLARUS 500 application and
Widows have both shut down completely.

To shut down the system:
1. To exit the application, click on the X in the upper right corner.

2. Select Shut down.
= The application closes and automatic shutdown tasks run.

3. When application shutdown is complete, click the Windows
icon on the desktop (lower left corner) and select Shut down.
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= Shutdown also turns off the CLARUS 500 acquisition head.

4. Turn off the power switch (1).
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7.1

A CAUTION!

7.2

7.3

7.1 Safety During Cleaning

Cleaning and Disinfection

Safety During Cleaning

Cleaning lenses too frequently
can damage optic surfaces.
» Clean optics only when necessary.
» Keep the protective cover on the instrument when not in use.

Cleaning Agents

instrument covers, chinrest, and
forehead rest

Distilled water, 70% isopropyl
alcohol in water, mild, ammonia-
free glass cleaner, or alcohol wipes

Volk LensPen® cleaning pen front lens
Optical cleaning set, Safebuds, or | front lens
cotton ball sticks

Microfiber cloth front lens

Cleaning the Front Lens

NOTE

7.3.1

Action

7.3.2

Action

Using harsh cleaning agents
may damage the device.

» Use only the recommended cleaning materials.

Removing Fluid Splashes

The most common cause of minor fluid contamination is from the
patient’s tears splashing onto the lens when the patient blinks.
These drops show up in images as light spots.

1. Start in the center of the lens surface and wipe in widening
circles with the felt end of the LensPen, applying gentle
pressure.

2. If the bright spots remain after repeated wiping, refer to
Removing Severe Contamination [+ 138].

Removing Minor Dust Accumulation

1. Use the brush side of the LensPen or the brush provided in the
cleaning set to quickly remove dust or other loose particles.
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2. If dust remains, start in the center of the lens surface and wipe
in widening circles with the felt end of the LensPen, applying
gentle pressure.

3. After using the felt tip, replace the protective cap and rotate it
three or four times.

7.3.3 Removing Severe Contamination

More serious contamination may result from patients sneezing or
touching the lens with their nose or fingers. This causes distinct
bright areas on the image.

Figure 23: Fundus Image with Fingerprint Contamination

Action 1. Using moist disposable cloths or microfiber cloths, cotton ball
sticks, or Safebuds sprayed with cleaning fluid, start in the
center of the lens surface and wipe in widening circles. Do not
allow your fingers to touch the lens surface as you clean.

2. Repeat as needed, using a clean portion of the cloth each time.

3. Verify that smudges and streaks have been removed by
breathing on the lens.

4. Use the felt end of the LensPen to remove any remaining
residue.

5. To verify that cleaning has been successful, take a photograph
in a darkened room. Check the resulting image for bright spots.

1387182 2660021165005 Rev. B 2017-10



Instructions for Use 7 Cleaning and Disinfection
2660021165005_Rev_B 7.4 Cleaning the Front Window Lens

Figure 24: Residual Bright Spots after Cleaning
7.4 Cleaning the Front Window Lens

7.4.1 Cleaning Heavy Contamination

Fingerprints, oil, or water spots should be cleaned immediately.
Skin acids attack coatings and glass, and can leave permanent
stains. Cleaning with solvents alone tends to redistribute grime.
These contaminants must be lifted from an optical surface with
soap or other wetting agent. The optic is then rinsed in water and
the water removed with alcohol. Acetone helps speed drying and
helps eliminate streaks from forming.

Action 1. Blow off dust.

2. Using a soap-saturated lens tissue placed around a swab, wipe
the optic gently in a figure-eight motion.

Repeat as necessary.
Repeat this procedure with distilled water.
Repeat again with alcohol.

o v kAW

Repeat once more with acetone.

7.4.2 Brush Cleaning Method

This technique is ideal for cleaning smaller optics, including lenses,
and involves holding a folded lens tissue with a hemostat to brush
the surface clean.
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NOTE Edges on mounted optics
are often hard to reach.

» Wrap a lens tissue around a swab.

» Soak the covered swab in acetone.

» Brush around the edge of the lens and then across the middle
using a continuous figure-eight stroke.

» Repeat if necessary.

Action 1. Fold a lens tissue so as not to touch the part of the tissue that
will make contact with the optic. The fold should be about as
wide as the optic.

2. Hold the tissue with hemostats parallel to and near the fold.

3. While holding the optic, using tweezers if necessary, blow off
any dust.

4. Soak the tissue with acetone.

5. Brush the fold in the tissue across the surface of the optic using
light pressure.

6. Repeat as necessary until the optic is clean, making sure new
lens tissue is exposed with each wipe.

7.4.3 Wipe Cleaning Method

For heavier cleaning of lenses and mirrors, this method involves
wiping an optic with a lens tissue by hand.
Action 1. Blow off dust.
2. Fold a lens tissue as with the brush method.
3. Apply acetone to the tissue.
4

. Holding the lens tissue in your hand with the fold near the tip
of your fingers, apply uniform pressure while gently wiping
across the surface of the optic.

5. Repeat as necessary until the optic is clean, making sure new
lens tissue is exposed with each wipe.

7.4.4 Dust Cleaning

Dust on optics can be very tightly bound by static electricity.
Blowing removes some dirt; the remainder can be collected by the
surface tension of a wet alcohol swab. Acetone helps promote
rapid drying of the optic to eliminate streaks.

Action 1. Blow off dust.

2. If any dust remains, twist lens tissue around a swab, soak in
alcohol, and wipe the optic in one direction with a gentle
figure-eight motion.

3. Repeat as necessary.
4. Repeat the steps above, using acetone.

140/ 182 2660021165005 Rev. B 2017-10



Instructions for Use 7 Cleaning and Disinfection
2660021165005_Rev_B 7.5 Cleaning the Chinrest and Forehead Support

7.5 Cleaning the Chinrest and Forehead Support

Do not spray cleaner directly on the chin rest or forhead
NOTE support.

Action » Before each use, wipe the chinrest and forehead support with a
non-acetone based spray or disinfectant wipe.

7.6 Peripherals and Table

Do not spray cleaner directly on the peripherals or intrument
NOTE table.

Action 1. Regularly dust or wipe down the instrument table.

7.7 Cleaning the PC Screen

Do not spray cleaner directly on the touch screen.

NOTE

Action 1. Turn OFF the instrument before cleaning the touch screen.

2. Wipe gently with a cloth that has been sprayed with a mild
glass cleaner containing no ammonia.
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8 Maintenance

8.1 Safety During Maintenance

Unqualified personnel

/A WARNING!
may injure themselves or cause damage to the instrument.

» Only trained, qualified personnel may use this device.
» This device may be used only for its intended purpose.

» Only ZEISS authorized personnel may perform maintenance or
repair procedures not described in this manual.

Do not service instrument while in use with patient.

A\ CAUTION!

Servicing instrument while in use with patient may cause injury.
» Complete patient exam with instrument before starting service.

8.2 Maintenance Schedule

Periodically inspect the CLARUS 500 to ensure that the instrument
is free of dust and the optics are cleaned as instructed. Frequency
of inspections depends on the frequency of use and the environ-
mental conditions.

External fixation Replace As needed
lamp diode

lllumination source | Check brightness As needed

8.3 Offline Teleservice

If an internet connection is not available, you can use offline
Teleservice to create a file with information and screen shots
related to the problem, which you can then send to ZEISS service.

Action 1. On the General Settings tab of the Settings window, under
Carl Zeiss Meditec Teleservice, select the Teleservice
Offline... button.

2. The offline Teleservice window opens.
3. Enter contact information and a description of the problem.

4. If you would like to include a screenshot of the problem,
clickAdd Screenshot.

5. Select Yes to agree to sending screenshots.
6. Select Screenshot to take a screenshot of your screen.
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7. Repeat as needed to generate additional screenshots, then
select Continue.

8. Select the network drive or USB flash drive to export the file to,
then select Continue.

9. A confirmation is displayed and the file “ServicePackage.svp” is
saved to the selected drive. Send the file to ZEISS service for
further assistance.

8.4 Data Storage - Backup

All data stored on the hard disk and any external media are the
Purchaser's records, and it is his or her responsibility to preserve the
integrity of these files.

Carl Zeiss Meditec is not responsible for the loss of patient files
stored on the hard disk or external media.

The Purchaser assumes the responsibility for the installation, use,
and results obtained from the instrument and programs.

8.5 Replacing the External Fixation Diode

Action » To replace the flashing diode at the end of the external fixation
lamp, unscrew it from the holder and replace it with a new
diode.
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9 Troubleshooting

9.1 Safety During Troubleshooting

Reconfiguring system components on the table, or adding
non-system devices or components to the table, or replacing
original system components with substitutes not approved
by ZEISS

could result in failure of the table height adjustment mechanism,
instability of the table, tipping and damage to the instrument, and
injury to operator and patient.

A CAUTION!

» Do not reconfigure system components on the table, nor add
non—system devices or components to the table, nor replace
original system components with substitutes not approved by
ZEISS.

Attempting to carry out activities not specifically endorsed

A CAUTION! by ZEISS

may void your warranty and could result in damage to the
instrument.

» Read the user documentation.
» Follow directions carefully.

» Do not make upgrades, or carry out repairs or modifications,
without specific guidance and instruction from ZEISS or an
authorized ZEISS represenative.

Using a non-approved or incorrectly connected device

/A CAUTION!
could invalidate the system safety approval.
» Follow all indications in this user document to ensure that all
connections are approved and correctly configured.
A WARNING! Unqualified personnel

may injure themselves or cause damage to the instrument.
» Only trained, qualified personnel may use this device.
» This device may be used only for its intended purpose.

» Only ZEISS authorized personnel may perform maintenance or
repair procedures not described in this manual.
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Component error occurred while
importing exam data.

System Malfunction

Call for Service

Connectivity exception occurred
while exporting the exam.

System Malfunction

Call for Service

Connectivity exception occurred
while exporting the exam.

System Malfunction

Call for Service

Database error occurred while
importing exam data.

System Malfunction

Call for Service

Error occurred while importing
exam data.

System Malfunction

Call for Service

Export process is stopped due to
Incorrect 10D data.

System Malfunction

Call for Service

Imager Initialization Failed

System Malfunction

Call for Service

The system has encountered an
error and must be rebooted before
acquiring additional scans. All work
has been saved. If this problem
persists, please contact ZEISS
customer support.

Continue in review mode or
Reboot.

System Malfunction

Call for Service

Mapper not found error occurred
while importing exam data.

System Malfunction

Call for Service

Montage could not be created with
selected images.

System Malfunction

Call for Service

Network data validation exception
occurred while exporting the exam.

System Malfunction

Call for Service

Network error occurred while
importing exam data.

System Malfunction

Call for Service

Network exception occurred while
exporting the exam.

System Malfunction

Call for Service

Number of exams that failed to be
exported.

System Malfunction

Call for Service

Path : '{0}' does not contain dcm
files.

System Malfunction

Call for Service

There is not enough space for
Montage, please remove some
images from Montage Bin.

System Malfunction

Call for Service
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9.3 Information Messages

You have exceeded the maximum
thumbnails limit of {0} in selection
bin. Please remove existing thumb-
nails from selection bin to add new
thumbnails.

System Malfunction

Call for Service

9.3 Information Messages

(hh:mm:ss:ms).

Amount of time for export Provides estimate of time it N/A
(hh:mm:ss:ms). takes to export file.
Amount of time for import Provides estimate of time it N/A

takes to import file.

Are you sure you want to delete the
selected thumbnail?

Confirms that you want to
delete the selected thumbnail.

m Click Yes to delete the selected
image.

m Click No to return without
deleting the image.

sheet.

Click images to change selection. Suggests optional action. N/A
Click images to save or discard Suggests optional action N/A
edits.
De-identify patient data. Confirms to hide patient infor- | Click OK.
mation such as name, date of
birth, ID.
Delete context menu item in proof- | Confirms that you want to Click OK.

remove an item from the
proof sheet.

Delete selected annotations?

Confirms that you want to
delete the annotations.

m Click Yes to delete the selected
annotations.

m Click No to return without
deleting the annotations.

Failed to save the log file.

Indicates that the log file did
not save successfully

Re-save the log file.

montage image cannot be deleted.

Exporting exams in progress... Indicates the progress of an N/A
exported exam.

Imager Initialization Succeeded Indicates completion of N/A
successful startup.

Images that are part of a UWF or Informs you that an individual | Click OK.

image you are trying to delete
is part of a montage, so it
cannot be delete.

Import all patient tests from
external usb media.

Confirms that you want to
import all tests stored on the
USB stick.

Click YES to import or NO to cancel
import.

2660021165005 Rev. B 2017-10
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appropriate number of
thumbnail images from the
stack.

Importing exams in progress... Indicates the progress of an N/A
imported exam.

Log file saved successfully. Indicates that the log file Click OK.
saved successfully

Number of exams selected for Indicates the number of exams | N/A

export. selected for export.

Number of exams successfully Indicates the number of exams | N/A

exported. exported.

Please select 4 thumbnails. Prompts you to select the Click OK.

Select auto import folder path.

Prompts you to select the
folder for imported images.

Browse to the folder you want to use
for imported images.

Select what you would like to do
with this thumbnail:

Message requires decision
about thumbnail.

Select Delete, Cancel/Delete, or

Replace

Set the export mode.

Message requires that the
export mode be set.

Set the export mode either Session,
Daily, or other choice.

Source and destination images are
both required in order to copy
annotations.

When copying annotations,
informs you when either or
both a source and destination
for the annotations is missing.

Click OK and select a source image
and a destination image for copying
annotations.

made to image.

delete your edits.

Tests will be merged with current Confirms that you want to Click OK.
database. save the scans in the
database.
Transfer Completed Informs you that your files Click OK.
transferred successfully.
You are about to delete all edits Confirms that you want to Click OK.

You have created a montage
image. Do you wish to save or
discard this image?

When attempting to select
something else, informs that
you created a montage image,
but did not save it.

Click Save or Discard.

be discarded if you leave this
screen. Discard before exit ?

without saving.

You have unsaved edits. Informs that you created a Click OK
montage image, but did not
save it.

You have unsaved edits which will | Confirms that you want to exit | Click OK
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9.3 Information Messages

Quick Compare

Shows all scans of same later-
ality and scan type as the
right-clicked image.

N/A

Table 12: Information Messages
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10.1 Electrical Specifications

10.1 Electrical Specifications

External Power Supply

100 - 240 V~, 50/ 60 Hz, 4 A max

Fuse

T40A, L250V

Electrical Class per IEC 60601-1

Class |

10.2 Instrument Specifications

Imaging Modes

m Reflectance images (true color,
IR)

m Live IR preview image

m Fundus autofluorescence with
blue or green excitation (FAF-
B, FAF-G)

m Stereo images

m External eye images

Mode of Operation

Continuous

Working Distance

25 mm, cornea to glass

Device Group (ANSI Z80.36, I1SO Group 1
15004-2)
Service Life 7 years

10.2.1 At-Instrument Computer Specifications

Data Ports 2 network, 4 USB3 (2 USB2)
Display Port v HDMI 2 RS232

RAM >8GB

Storage >1TB

Screen Resolution 1920 x 1080

Gigabit LAN port

RJ45, bandwidth = 125 MB/s

Touchscreen

PCAP

2660021165005 Rev. B 2017-10
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10.3 Dimensions and Weight
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Dimensions (W x D x H)

362 mm by 546 mm by 676 mm

Instrument Table Dimensions (W x
D x H)

916 mm by 615 mm by 711 - 925
mm

Acquisition Device Weight 20.9 kg
At-Instrument Computer Weight 8.5 kg
Instrument Table Weight 38 kg

10.4 Ambient Requirements for Operation

Temperature

10°Cto 35°C

Relative Humidity

30% to 90%, non-condensing

Atmospheric Pressure

800 hPa to 1060 hPa

10.5 Ambient Requirements for Storage

Temperature

-10°Cto 55°C

Relative Humidity

10% to 95%, non-condensing

Atmospheric Pressure

700 hPa to 1060 hPa

10.6 Ambient Requirements for Transport

Temperature

-40°C to 70°C

Relative Humidity

10% to 95%, non-condensing

Atmospheric Pressure

500 hPa to 1060 hPa

10.7 Fundus Camera Specifications

Field of view

m Widefield = 90°

m Ultra-widefield m 135°
Ametropia Compensation +20Dto-24D
Pixel Pitch on the Fundus 7.3 pm/pixel

1527182
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10.8 Laser Classification

Resolution (zones defined in 1ISO
10940):

® 60 Ip/mm at central field (0°)
m Center m 40 Ip/mm at 23° FOV
= Middle m 25 |p/mm at 45° FOV
m Periphery
Sensor:

m Color Imaging

m Fluorescence Imaging

3 x 12 megapixels

12 megapixels monochrome

10.8 Laser Classification

Class 1 laser product

2660021165005 Rev. B 2017-10
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1

11.1

11.2

11.3

11.1 Software Copyright

Legal Notices

Software Copyright

The software program (“Software”) included with your CLARUS™
500 is a proprietary product of Zeiss and in certain instances
contains material proprietary to Microsoft Corporation and other
third party licensors, suppliers and vendors. These proprietary
products are protected by copyright laws and international treaty.
You must treat the Software like any other copyrighted material.
Copyright ©2017 Carl Zeiss Meditec, Inc. All rights reserved.

End User Software License Agreement

Upon initial configuration of your CLARUS™ 500, you will be
presented with an End User Software License Agreement (the
“EULA"), which you must accept in order to use the Software. The
EULA is a legal contract between You and Carl Zeiss Meditec, Inc.,
which governs Your use of the Software. If you do not agree with
the terms and conditions of the EULA and do not agree to be
bound by the EULA, do not use the Software. If You have any
questions concerning the EULA, contact Carl Zeiss Meditec, Inc.,
Attention: Customer Service, 5160 Hacienda Drive, Dublin, CA
94568. Telephone 800-341-6968.

Acknowledgment

You acknowledge that you have read all the provisions in this
Chapter, including End User Software License Agreement, under-
stand them, and agree to be bound by their terms and conditions.

2660021165005 Rev. B 2017-10
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12

/A WARNING!

12.1 Parts Orders

Accessories and User Replaceable Spare
Parts

This section contains parts lists for this instrument, instructions for
ordering parts and instructions for returning defective parts.

Using parts that are not authorized by ZEISS
may compromise device safety during operation.
» Use only accessories authorized by ZEISS.

» In the U.S., call 800-341-6968. Outside the U.S., contact your
local Zeiss distributor. You can find the ZEISS contact partner
for your country on our website: www.zeiss.com.

NOTE

The procedure for returning defective parts from Interna-
tional operations differs somewhat from that for U.S.
domestic operations

These differences are noted in the instructions.

» Please follow the instructions carefully.

NOTE

12.1

12.1.1

12.1.2

Part numbers are subject to change

» When ordering, confirm all part numbers with your ZEISS
Representative.

Parts Orders

U.S. Domestic Parts Ordering

Spare parts may be ordered as needed following established parts
ordering procedures. Parts needed overnight may be ordered by
phone from the Parts Department. The cost of shipping parts for
next day delivery is very high and should be used only in
emergencies. The Parts Department phone number is:

m 1-800-341-6968 (domestic toll-free)
m 1-925-557-4843 (domestic)
m 1-925-557-4652 (domestic fax)

International Service Operations

Customers are billed for shipping charges, including any customs
fees required.

For International Service Operations, please use the ordering proce-
dures that have been established for your area of operations, and
which meet the requirements of the Carl Zeiss Meditec Interna-
tional Parts Department.

2660021165005 Rev. B 2017-10
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12.2 Accessory Kit Parts List (Replaceable Parts)

2660021166733 DUST COVER CLARUS
2660100007672 LENS CLEANER
resco
=l
hans
Cleaner
= 2660100007673 LENS WIPES
e 50 %=
neFEN o
Lens ©
pape’ e
ST
2=
2660021121819 CABLE NETWORK CAT5E
SNAGLESS BOOT
2660021165915 SCR M6X1 X16 THUMB
2660021167011 BRACKET ACCESSORY BAG
c—— 2660100022511 POWER CORD 120V
& =
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12 Accessories and User Replaceable Spare Parts

12.3 Additional Replaceable Parts

2660021147390

1 WIRELESS MOUSE

12.3 Additional Replaceable Parts

—4 2660021167501

Accessory bag

2660021167244 Fixation Device (External)

3197519005000 Occluding Sleeve for Fixation
Device

3013509052000 Fixation Lamp (Red)

2660021165748 Ocular Lens Cover

2660021158754 Ethernet CAT5E Shielded

1.5 m/59 in

Q 2660021140192

USB Display Port Cable
2m/79in
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1597182



12 Accessories and User Replaceable Spare Parts Instructions for Use

12.4 Returning Defective Parts

12.4

12.4.1

12.4.2
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Returning Defective Parts
Receiving returned parts helps us to:
m Evaluate defects and analyze root cause.
m Rebuild and return servicable parts to stock.

Equipment Return Authorization

Authorization must be obtained from Carl Zeiss Meditec before
equipment is returned for repair. A Return Material Authorization
(RMA) number is required on each return shipment to Carl Zeiss
Meditec.

The procedure for obtaining an RMA number varies, depending on
your area of operation. Use the procedure that has been estab-
lished by Carl Zeiss Meditec for your area of operations.

Packing for Shipment

Defective instrument subassemblies/parts should be packed in the

shipping container received with the replacement subassembly or

part. If necessary, contact the Carl Zeiss Meditec Parts Department
for a replacement shipping container.

Shipping containers are not available for assemblies that are
supplied by a separate vendor (i.e., monitor, printer, keyboard,
computer) so it is important to preserve those shipping containers
when the instrument is first received by the customer.
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13 Decommissioning

13.1 Safety During Decommissioning

Attempting to decommission your system
may result in damaged equipment and danger to personnel.

» Never attempt to decommission a ZEISS system or device. Only
ZEISS approved field service representatives are qualified to
safely decommission your system.

» Contact your ZEISS Representative to set up an appointment for
system/device decommissioning.

A CAUTION!

2660021165005 Rev. B 2017-10 1617182
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14 Packaging and Transport

14.1 Safety During Transport

A CAUTION! Packaging and transport by non-ZEISS personnel

could result in damage, loss, or non-compliance within the country
of transit.

» Allow only change to Zeiss approved representative to prepare
the instrument and associated components for transport.

» Allow only ZEISS-approved personnel to transport the
instrument and associated components.
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15

15.1

15.2

15.1 Packaging Disposal
Disposal

Packaging Disposal
m Keep instrument packing material in the event of a relocation or
repair.
m |f you want to dispose of the packing material: Dispose of

packing material by sending it for recycling through an
acknowledged collection system.

Instrument Disposal

The device contains electronic components with integrated
batteries.

» Dispose of the device and integrated batteries correctly, in
accordance with national legislation.

The device specified on the delivery note must not be disposed off
via household waste or communal disposal companies according to
the applicable EU guidelines valid at the time the device was placed
on the market.

» For more information about the disposal of the device, please
contact the ZEISS contact partner in your country.

» If you want to sell on the device or its components: Inform the
purchaser that they must dispose of the device according to the
regulations valid at that time.
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Glossary

DHCP

a client/server protocol that automatically
provides an Internet Protocol (IP) host with
its IP address and other related configu-
ration information such as the subnet mask
and default gateway.

DICOM

DICOM (Digital Imaging and Communica-

tions in Medicine) is an open standard for

the archiving and exchange of information
within medical image management.

DNS
a hierarchical decentralized naming system
for computers, services, or other resources
connected to the Internet or a private
network. (The Internet's equivalent of a
phone book.)

EMR

Any electronic medical records system,
including FORUM, whether DICOM-
compatible or not

ePDF

a DSC-conforming PostScript document
with additional restrictions intended to be
usable as a graphics file format.

ETDRS

aids in evaluating the changes in vision in
patients with diabetic retinopathy.

FAF
Fundus Autofluorescence. A type of fundus
imaging in which the eye is illuminated with
light at a wavelength that stimulates the
natural fluorescence of lipofuscin.

FAF-Blue

Fundus autofluorescence with blue
excitation

FAF-Green

Fundus autofluorescence with green
excitation

FORUM

A software product for managing,
archiving, and viewing patient data,
images, and reports from computerized
diagnostic instruments or documentation
systems.

FOV

Field of View. The measure that indicates
how much of the eye can be imaged in a
capture. Field of view can be measured
from the pupil, as described in 1ISO 10940,
or it can be measured from the center of
the eye.

10D
Information Object Definitions

IR

is @ non-invasive en face imaging technique
capable of visualizing sub-retinal pathology

JPEG

a commonly used method of lossy
compression for digital images, particularly
for those images produced by digital
photography.

JPEG2000

an image compression standard and coding
system reated by the Joint Photographic
Experts Group committee in 2000 with the
intention of superseding their original
discrete cosine transform-based JPEG
standard (created in 1992) with a newly
designed, wavelet-based method.

LEDs
a two-lead semiconductor light source.

2660021165005 Rev. B 2017-10
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NETBIOS

a program that allows applications on
different computers to communicate within
a local area network (LAN).

NTP

a networking protocol for clock synchro-
nization between computer systems over
packet-switched, variable-latency data
networks.

PACS

a medical imaging technology used for
storing, retrieving, presenting and sharing
images produced by various medical
hardware modalities, such as X-ray, CT
scan, MRI and ultrasound machines.

PDF

a file format that provides an electronic
image of text or text and graphics that
looks like a printed document and can be
viewed, printed, and electronically trans-
mitted.

PNG

a raster graphics file format that supports
lossless data compression.

Proof

A screen that presents thumbnails of all
images associated with a patient record.

Selection bin

The list of thumbnails of the images that
have been selected from the Proofsheet.

Stereo image

An image that simulates a three-dimen-
sional image by placing two images side-
by-side that were taken from slightly
different angles.

TCP/IP

a suite of communication protocols used to
interconnect network devices on the
internet.

2660021165005_Rev_B

TIFF

a computer file format for storing raster
graphics images, popular among graphic
artists, the publishing industry, and photog-
raphers. TIFF is widely supported by
scanning, faxing, word processing, optical
character recognition, image manipulation,
desktop publishing, and page-layout appli-
cations.
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Index

Numerical

1-Up, 2-Up, 3-Up, 4-Up 8-Up, 9-Up or 16-Up ...
116
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A ANalyze SCaN ... 114

Accessing the User Manual .......................... 23 Analyze Wiindow

ACCESSOTIES ...t 157 OVIVIEW ..o 32

Accessory Bag, Ordering Replacement....... 159 Analyze: ReVIEW........cccuvviiiiiiiiiiiiicciie 114

Accident REPOIting .........coovevveeeeeeeeeenin, 18 ANNOtatioNS......evviiieiiie e 121

Acquire AMTOWS ... 123
Acquire Window ............ccovvvereeeneenn. 29 BULtON ..o 34
AULO MONAGE ... 104 Caliper (Measurement).......................... 124
BULLON oo 30 Circle oo 125
External Eye IMage.........cocovvvveveennn.. 108 Copy & Paste .....cccccveviiii, 127
Montage IMage .........cooveeevreereeren. 105 Deleting .....covvveeiiiiieei e 130
SEEre0 IMAGE ..., 107 EXPOrting ...ccoviiiiiieee e 53
Ultra-widefield Image..........coovvvvvne.n.. 103 Freehand Shape..........cccccoiiiiiiiin 126
Widefield IMage.........ovvveeeeeeeeeeeeeen. 102 HIidiNg ..o 129
Window OVerview ...............c..cccccoco...... 31 Image Brightness ... 131

Acquisition IMPOrtiNG...ccoiiiiiieee e 52
Configuring Settings ..........ccovovevceevevennn, 69 TEXT oo 122

Add a Patient Record ... 46 Tool Panel ... 122

Add BUHON ... 30 £00M IN/OUL ..o 121

Add USET ....oovoo 59 ANSIZ80.36 ..o 9

Adjust ANti=VIrUS ..o 71
AIGNMENT ... 31 Application
ChinRest ... 27 VEISION ..o 45
CONEFASt.... oo, 34 Application Upgrade.............cocoois a1
FOCUS .ot 28 AITOW ANNOTALIONS ..o 123
Friction (Acquistion Head Movement) ..... 28 Arrow, Annotate Image.............co.oo 121
Number of IMages ..........ccooveveereenen, 34 Assign Patient IDS .......covveviveeiiiee 68
ROTATION ..o 34 Atmospheric pressure requirements........... 152
Saturation ........oooveiiieie 34 Authorization to Return Parts................... 160
SRAMPNESS ... 34 Auto
Table HEight ..o, 90 Screen LOCK ....vveveiiiiieiiice e 71
Thumbnail Size.............. 33 AUto BUTION ..o 110
VOIUME ..o 30 Auto Montage

Administrator CaptUNiNG..ceee e 104
Change Password ..........c.cocoovevceevevennn, 60 Autoflourescence
Delete ..o 59 (5€€ FAF) oo 24

Administrator, Add NeW .........ccooevveeeeeen.. 59 Automatic Data Backups, Configuring ......... 62

Advanced BUTtON ............o.cocoooiiiieie 30 Automatic EXport............coo 56

Alerts Automatic FOCUS........oovviiiiiiiiiee, 110
Clearing HiStory .........ocoovveeeeeeeeeeeee. 70 Automatic Import ..o 55
Setting Display Time.........cccccveiiiiinnn. 68

Align
PrevieW ..o 31

Align Patient's Eye .....cccviiieiiiee 92

Alignment, Eye ... 93

Al BUTTON Lo 31

All-iN-0Ne PC...oiiiiiiiicc 25

Analyze
Open Analyze Screen ........cccccoevvveeen.n. 114

Analyze BUtton .........ococviiiiiiii 31, 32
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Backing up Data Automatically ................... 62 CaliPer ..o 122
Backing up Data Manually ...................ooe 63 Caliper, ANNotations ..........cocciviieiiiiienn. 124
Blink Fixation Target Button......................... 32 Capture
Blinking the Internal Fixation Target........... 109 Auto Montage .......cccvvveiieeiiiiiceee 104
Blue Channel, Viewing...........ccccooeviineenns 119 External Eye Image.........ccccooviiieiennne 108
Bright spots on images, removing.............. 138 Montage Image .......cccuvvveviviiiiiiieiiieeee. 105
Brightness BUutton .........cccccceeviiiiiiceeee 34 Stereo Image ... 107
Broadcast POrts........cccoovvviiiieiiiieee 72 Ultra-widefield Image..........ccccccceveenne. 103
Bulk Export, Exam Data ..........ccccceveeeeinnne. 53 Wide Field Image .......cccccoevviiieiene 102
Bulk Import, Exam Data ..........ccccciieeernnnnne. 52 Capture Bin ..o 32
BUttON ..o, 34, 35 Capture BUtton .........evvveiiiiiieiiiiiiin 32
BUTTONS .. 30 Carrying the Instrument Caution................. 17
ACQUITE .ot 30 Cautions
Add Patient........ccooiiiii 30 Carrying the Instrument ...............ccccee. 17
AllL 31 Decommissioning...........ceeeevriiiiieeeeannnnne. 16
ANAlYZE....oiii 31, 32 DefiNitioN ...ceve e 12
ANNOTAtIONS ...t 34 Disregarding EMC Information................. 18
Blink Internal Fixation.........c.ccccocvveeninne. 32 EMC PrecautionsS.........cccovvvveeiiiiieiiiinens 16
CaPTUre. e 32 Flickering Lights ........cccooiiiiiiiii 16
Clear ..o 33 Image Degradation ..........cccoeeiiiieennnne. 17
CONTrast. . oo 34 Improper Cleaning ........cccccoeeviiiieeennnne 15
EXIT oo 30 Internet Security........cccovveiiiiiii. 15
Favorites ... 33 Operator Traning ........cooeeeeeeeieiiiiiiiis 87
Fixation Target Location............c.ccc....... 32 Packing and Transport ..........cccceeeeeennee. 16
FOCUS .o 32 Portable RF Equipment..........cccccceeernnne 17
Hide Screen .......cccccvviiiiiii 29 Power DOWN.........coviiiiiiiiiciiec e 135
LOQOUL ..eiiiiiii e 30 Prohibited Activities ...........ccccciieiinnne 15
Minimize the Application ........................ 30 Proper Procedures...........ccccooviiiineennnnne. 15
MoONtage.......oovviiiiiiiii e 34 STAMTUP . e 43
MY o 32 Use in Healthcare Facility ...........c............ 17
Myd or Non-Myd .........cccccoiiiiiiiiie 32 Central Fixation Target........cccccccooviiinnennn, 99
NON-Myd ... 32 Change
NUMDBErS ..o 34 Laterality ......cooovevieeii 51
Patients......cooeeeeeiiee 32, 33, 35 Change Password ...........ccocoeiiieeininne. 60, 61
Print Report ........ooviiiiiiiiieceee 34 Chin REST .. 91
ProOf (e 34 AdjustmeENnt .......ccoeeiiiiii 27
REVIEW ..o 33 Identifying .......oooeieii 27
ROt .. 34 Chinrest, cleaning the ..........cccccccc 141
Saturation ... 34 Circle ANNotations .........ccocevviieiiiinieinn. 125
AV . e 34 Circle, Annotate Image ........cccccceeevviinnnen. 122
SEArCh v 30 Cleaning ... 141
SettiNgS woveeeie 30 CAULION .. 15
SharpnNess ......ooooiiiiieeei e 34 Front window lens .............ccccceeeene 139
SO e 33, 34 Peripherals........ccccoiiiiiii 141
STEIEO .. 34 Safety oo 137
Thumbnail Size (VieW) ......ccovveieiiiienein, 33 Table o 141
TOdaY ..o 31 Cleaning agents......cccccvveeeiiiiiiiecce e 137
Volume Control .......ccccovviiiiiiiiiiiincs 30 Clear BUTtON ......oviciiiiiicic 33
ZOOM ..ttt 34 Clearing Alert History .........cccocoeiiiiiiiieeenn, 70
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Color Images

ADOUL ..o 98
Viewing Separate Color Channels.......... 119
Comments, Submitting ...........ccccooviiiinnnn. 23
Compare IMages ........ccccceeviiviineeeiiiiiieen. 116
Compliance
ANSIZ80.36 ..o 9
EN ISO 15004-2 1\ 9
[EC 608251 ...oiiiiiiieeeiiee e 9
[EC 6100074 ...t 19
ISO 10940:2009 ....oooiiiiiieiiiiieeeieee e 9
ISO 15004-1:2006 ......evvveeiiiiieiiieeeiiie 9
[SO 15004-2 ..o 9
ROHS 9
Compressed Files, Automatic Export............ 56
COMPULET ... 25
Configuration
Acquisition Settings ............ccccoeiiiiiis 69
EXPOrt.. 56
Import Settings .........ccooeiiiiiiiii, 55
Institution information ..............cccccoeee. 68
Language..........oooooiiiiiii 68
Local area network setup.........ccccoeevneee. 67
Printouts ... 69
REPOITS .., 69
TIME ZONE ... 68
Configuring
Data Backups........ooeviiiiiiiiieiiiee, 62
Connecting Wireless Printers..............cc.c...... 65
Contrast BUttoN .........evevveveiiii, 34
Copy
ANNOatioN .....ooooiiii 122
Copy Annotation ..........ccccveeiiiiiiiiice 127
Copyright
SOftWAre ..o 155
Cross Table
(see Table) ... 28

2660021165005_Rev_B

D
Data

Automatic Backup.........ccccoviiiiiiiinn 62

IMPOrting.......coooiii e 52

Manual Backup........cooceeiiiiiiie, 63

Safety oo 71
Data Management

Integrity of imported records .................. 53

LOg FileS. ..o 64
Database POrts .......ccccooviiiiiiiiiiee 72
Date

SOrtiNG BY e 115
Date and Time

System, Setting ... 68
Date Filter.......oooiiiiiiiii e 33
Decommissioning

Packing and transport..........cccccceee 163

Safety oo 161
Decommissioning Caution ............cccevveveneee. 16
Defective Parts, Returning.............cccccoee.. 160
Delete

ANNOtation ... 122

Patient ReCords.........oovviiiiieiiiiiiieees 50

SCAN ..ot 113
Delete User......ooeiviiiiiiiiiieeeeee e 59
Deleting Annotations...........ccccevviiiineeenn. 130
Demographic

DOCTOrS .o 22

OPErators ......cooovviieeeiiiii e 21

Patients......o 21
DHCP .o 67
DHCP POt .o 73
DICOM

Automatic EXPOrt........eeeeeeveiiiiiniiininnnnn. 56

POIES 72
Disposal

Batteries . ... 165

Electronics .....coovviiiiiie 165

Instrument.......cccooeiiiiiii 165

Packing material ............ccccoooiiiiiii 165
Distributed Data Service Port ....................... 72
DNS POTt .o 73
Doctor

Add NeW .....oooiiiiiiiiiiicc 59

Change Password ...........ccccceveeeiiiiine.n. 61

Delete ..o 59
Doctors

Intended DemographicC .........ccccccoeeinne 22

Required SKills.........ccooiiiiiii, 22
Down, AdjustTable .........cccccccoiiiiiiii 90
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Draw, Annotate Images.........ccccceeeeeeeeeeen. 121 F
Drives, Mapping .........oooooviiinninns 66 FAF oo 99
Duplicate Patient, Merging Records ............. 47 FAF-B
Definition......coooiiiiii 24
= FAF-G
Edit IMAges......c.cccovvvieiiiiciecieeeee e 116 Definition ......cccooiiiiii e 24
Electrical Safety........cccoviiiiiiiiie 9 FAF-Green ........cccoiviiiiiiiiiiiiiicecec 99
Electromagnetic Compatibility (EMC) ........... 18 Favorites Button ..., 33
Electromagnetic EmMissions................c.......... 19 Field of VIeW ..., 24
Electromagnetic Immunity ...............ccoooee 19 Filiters
EMC Precautions...........coccevviiiiiiiiiciiiieeee 16 Date. . i, 33
EMR SCAN TYPE e 33
Automatic EXPOrt.........ccevveviieeeiiieeeiene, 56 Filtering IMmages ........cooooveeviiiiiicen 115
Reconciling local records with EMR records.. Filters
46 OU, OD, OS ..oiiiiiiiiiieeee e 33
ENISO 15004-2 T..ivviiiiiieiiieaeeieeee e 9 Find a Patient .........ccoooviiii 30
End User Software License Agreement....... 155 Finding a Patient Record..................cccocoeis 87
Environmental requirements ...................... 152 Fine FOCUS .......oooiiiiii, 93
Equipment Return Authorization................ 160 Fixation Target
Error Messages ......ccueeevvveevveeeciieeciieeeee, 147 BIiNk BUTEON ..o 32
Essential Performance.............ccccovieiiiennnnn. 18 Blinking.....oooeiiee 109
Ethernet Cable External ..o 112
Ordering Replacement ..........cccccceeveennn 159 External, Ordering Replacement............ 159
Exam Data Internal ... 99
EXPOrting ..covvveeeiieeeee e 53 POSItIONING ... 111
IMPOrtiNg.....coveeiiieeee e 52 Presets ..o, 100
REASSIGNING....coeiiiiieiiiiieeecee e 48 Visibility Tips ..ooovvveeiiiiicecc 100
Exit Fixation Targets
BUTEON oo 30 Ordering Replacement Lamp................. 159
Exit Application, Automatic Export............... 56 Flammable Gas Warning...........cccccoovvennnnnn 13
Export Flickering Lights Caution............ccccccoeeenne 16
Audit Log files........coooviiiiiiiiiii 64 FOCUS ..t 93
File FOrmats .......oovveeiiiiiiieeeeeeceee 56 Adjustment Knob............ccooeiiiiiin 28
Export, Configuring ..........cocooveiviiiiiiie, 56 Automatic or Manual............cccccceeennnn. 110
EXpOrting SCans ..........oooviiiieiiiiiiieeee 53 FOCUS BUTTON ...ovveiiiiciiiic e, 32
Extension Cord Warning ...........ccccccceeeenee. 15 Forehead Rest.........cccoviiiiiiiiiiic, 91
External Eye Image Forehead Support
CaptuMNg....ccveeeiiiiieecee e, 108 Identification.........cccooiiiiiic 27
External Fixation Forehead support, cleaning the ................ 141
BUTEON oo 32 Format, File, Automatic Export.................... 56
External Fixation Target FORUM
[dentifying ......coooviiiiiiee 29 Automatic EXport.........cccevveeiiiniciiiienns 56
Ordering Replacement ..............cccueeee. 159 POItS ..o 72
Ordering Replacement Lamp................. 159 Freehand Shape for Annotations................ 126
USING 1o 112 Freehand Shape, Annotate Image.............. 122
Eye Friction Adjustment ..............cccooiiiis 28
FOCUSING ..o 93 Front Lens
Eye, AligNing......ccccovvieiiiiiiiiiie e 92 1dentifying .....oooveeiiiii 27
Eyelid Lift. ..o 89 Front lens, cleaning the ... 137
Fundus AutoFluorescence
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(S€E FAF) e 24 |
ID, Patient, Identifier........ccccoeevveviieiiiiinn, 68
G IEC 608251 ..o 9
Green Channel, Viewing ..........cccccoevvveennns 119 Image
ANalyze......cooii 114
H Auto Montage, Capture...........ccceevnenne 104
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